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18 Summary of the Axxon PSIM utilities
Additional Axxon PSIM software utilities are separate software applications intended to perform additional 
operations when setting up and working with Axxon PSIM software. This document describes the following utilities:

The utility for reading video capture card code and dongle
Converter.exe utility for converting video and audio archives
Tweaki.exe utility for advanced setup of the Axxon PSIM software system
The utility for collecting configuration data on servers and RWS for the Technical Support
The Fps.exe utility for productivity estimation
The SignCheck.exe utility for checking the authenticity of exported frames
The Convert.exe utility for correcting modification dates of video archives
The ddi.exe utility for editing database templates and external settings files
The Arpedit.exe utility for creating user dialog windows
The idb.exe utility for converting databases, selecting database templates and making backup copies of 
databases
Configuration check tool
Index.exe utility for reindexing archive files
The shedule.exe utility for creating a replication query file
The Axxon Player utility for viewing and converting the video archive
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19 The utility for reading video capture card code and dongle

19.1 The purpose of the CodeReader.exe utility
The CodeReader.exe utility is designed to read the dallas code of the cryptochip (chip) of the video capture card, 
which determines the card type, HID of computer and the number of the Guardant dongle.

19.2 Starting and shutting-down the utility
To start the CodeReader.exe utility, do one of the following:

Start the utility from the Windows taskbar. Click Start, then All Programs, then Axxon PSIM, then Tools, 
then Read hardware codes. The CodeReader.exe utility is available for the following types of Axxon PSIM™ 
installation: Server and Remote Admin Workstation.  

Start the utility from the Tools folder of the Axxon PSIM folder. Example: C:\ Program Files\Axxon 
PSIM\Tools\CodeReader.exe.

The Code Reader dialog box will open.

Note.

 For proper operation of the utility Axxon PSIM™  is to be shut down.

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To shut down the CodeReader.exe utility, click the   button.

19.3 Using the CodeReader.exe utility
The CodeReader.exe utility allows determining the type of installed video capture card by its dallas code(s), HID of 
computer, as well as the number of the Guardant dongle. To read this information, start the utility (see the Starting 
and shutting-down the utility section). The type of video capture card, its dallas code(s) and the number of the 
Guardant dongle and HID will be displayed in the Code Reader dialog box.

 

The number of dallas codes depends on the number of chips on the video capture card. Figure shows that the FS6 
card with 4 chips has been used.
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19.4 Portable version CodeReader_portable.exe
The portable version of the utility for reading the video capture card codes and dongles is the executable file 
CodeReader_portable.exe. This file can be downloaded from the official AxxonSoft website.

The CodeReader_portable.exe file can be launched on any computer even without Axxon PSIM installed.

The purpose and interface of the portable version, as well as the procedure for working with it are similar to the 
standard version of the CodeReader.exe utility – see The utility for reading video capture card code and dongle.

Attention!

For the portable version of the utility to operate, you need to install the latest versions of the Visual C++ 
redistributable packages for Visual Studio. 
To check the availability of the Visual C++ redistributable packages for Visual Studio, select Start -> 
Control Panel -> Programs -> Programs and Features.

If there are no redistributable packages, you can download them from the official website at: https://
learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170, or install the file that 
is available in Axxon PSIM installation directory in the Redist -> Dotnet4.5 folder.



https://learn.microsoft.com/en-us/cpp/windows/latest-supported-vc-redist?view=msvc-170
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20 Converter.exe utility for converting video and audio archives

20.1 The purpose of the Converter.exe utility

The Conveter.exe utility is designed to play video and audio archives, and to convert them to standard formats: 
MPEG, DivX, etc.

Besides video and audio playback, Converter.exe utility is used for:

Converting audio and video files.
Copying the files from the archive to another folder with no data loss.

The utility can be started from the Tools folder of the Axxon PSIM program folder or from the Start menu: Start -> 
Programs -> Axxon PSIM -> Utilities -> Playback and Conversion.

The utility dialog box is shown in the figure.

Important!

Correct operation of the Converter.exe utility on Windows 10 and newer OSes is not guaranteed.


Note.

 If video and audio were synchronized at the time of recording, the converted video file will contain sound 
track.


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1.

2.

20.2 Starting and shutting-down the Converter.exe utility
To start the Converter.exe utility, do one of the following:

Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Video player 
and file converter. The Converter.exe utility is available from the Start menu with the following installation 
types of the Axxon PSIM software: Server, Remote administrator workstation, Remote client.

Start the utility from the Tools folder of the Axxon PSIM program folder. Example: C:\Axxon 
PSIM\Tools\converter.exe.

Archive Converter dialog box will open.
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To close the Converter.exe utility, either click the cross button in the top right corner of the dialog box, or press 
Alt+F4 on the keyboard.

20.3 Converter.exe interface

20.3.1 The Archive's Converter dialog box
The dialog box of the converter.exe utility is shown in the figure.
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The Archive's Converter dialog box comprises of the following elements:

The screen to play back recordings (1);
The control panel for video and audio recordings playback (2). 
The elements of the control panel are described in the table.

№ Element name Description

1 Recording start date and time Fields for entering the approximate start date and time of the 
video or audio recording

2 Recording end date and time Fields for entering the approximate end date and time of the 
video or audio recording
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№ Element name Description

3 Go to first / last frame Buttons for quick moving of the slider to the beginning or the 
end of the recording

4 Device Drop-down list field for selecting the device (camera, 
microphone), for which the recording should be found in the 
archive

5 Device number Drop-down list field for selecting the number of the device, for 
which the recording should be found in the archive

6 Search Button for starting the search of recordings in the archive of the 
chosen device. The recordings are searched in the entire archive 
of the device. After the search is completed it is possible to 
specify the approximate beginning ang end date and time for 
required recording

7 Playback panel The panel contains typical standard functions (from left to 
right): backward, play, pause, stop, forward

8 Time scale The scale allows monitoring the playback progress and moving 
between the frames. To move between the frames, drag the 
slider or use the playback panel buttons in a per frame playback 
mode

9 Export setup The button for opening the Export Setup dialog box

10 Exported recording limits The buttons for setting the first and the last frames of the 
exported record

11 Hide/show the list The button for hiding and showing the list of selected 
recordings

12 Add to list The button for adding the selected recording (recording 
segment) to the list

13 Print frame The button prints the current frame

14 Frame export The button exports the current frame in a specified format. A 
dialog box opens for selecting the folder on the disk and 
entering the file name
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№ Element name Description

15 Export to AVI or archive The button for starting the export of the recording (a recording 
segment) in the specified format. A dialog opens for selecting 
the device name, which made the recording. On export start, a 
folder is created for saving the exported recordings (by default, 
C:\Backup)

20.3.2 The Export Settings dialog box

To open the Export Settings dialog box, click the  button in the Archive's Converter window. The Export 
Settings dialog box will open, allowing to specify export parameters.

N
o

Parameter 
name

Field type Description Form
at

Default value Value range

The Choose folder group
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N
o

Parameter 
name

Field type Description Form
at

Default value Value range

1 Destination Type-in the 
value

Type-in the folder on the 
disk to store the 
exported files (by default 
the Backup folder is 
created on disk C:)

- - -

2 Volume Size, 
MB

Type-in the 
value

Type-in the maximum 
value of the volume (file) 
size containing one or 
more recordings.

If the size of recording for 
export exceeds the set 
one, then it will not be 
split.

When the recording is 
added to the volume, the 
size of recording is 
expected to equal the 
mean value of sizes of all 
added recordings. A new 
recording is added to the 
volume if it does not 
exceed the volume size. A 
real size of recording can 
differ from the assumed 
one, therefore the 
volume size can exceed 
the assumed one.

If the Break To Alarms
checkbox is checked, 
each volume will contain 
one recording only. The 
field is disabled if the 
Native Archive
parameter is activated

MB 650 0 to 2000 MB

3 Frames per 
second

Select in a 
drop-down 
list

Type-in the amount of 
grooming of the video 
recording

fps RealTime 0.5; 1; 3; 5; 15; 30; 
RealTime
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1.
2.

1.

2.

N
o

Parameter 
name

Field type Description Form
at

Default value Value range

4 Native 
Archive

AVI File

Select a 
radio-button

If the Native Archive
radio-button is selected, 
then  archive fragments 
will be exported keeping 
the creation time, but 
with no AVI conversion. If 
the AVI File radio-button 
is selected, then the 
fragment is converted to 
the AVI format using the 
specified codec

- AVI File Native Archive
AVI File

5 Break To 
Alarms

Checkbox The checkbox is for 
selecting the way of 
storing the archive 
export fragments to 
volumes (files of 
specified size): the 
recordings for each 
alarm will be saved to 
separate volumes (files)

- Unchecked Unchecked – the 
file (volume) will 
contain a fragment 
of the size specified 
in the Volume Size, 
MB field

Checked – the 
volume will contain 
a fragment related 
to one alarm only

6 Native 
Format

Checkbox If the Native Format 
checkbox is checked, 
then video recordings are 
exported to AVI file 
without recompression, 
i.e. in the same format as 
in Axxon PSIM archive. To 
playback these AVI files 
on the computer without 
Axxon PSIM software 
package installed, install 
components from Axxon 
PSIM distributive 
beforehand:

\Redist\VC2005_SP1\
vcredist_x86.exe
\Redist\CamMonitor\
CamMonitorInstaller.
exe

Note. To playback AVI 
files use Windows Media 
Player

- Unchecked Unchecked – Axxon 
PSIM archive is 
exported to AVI file 
with recompression

Checked - Axxon 
PSIM archive is 
exported to AVI file 
without 
recompression
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N
o

Parameter 
name

Field type Description Form
at

Default value Value range

The Frame Export group

7 Bitmap

Jpeg

Select a 
radio-button

 If the Bitmap radio-
button is selected, then 
the file is saved in Bitmap 
format.  If the Jpeg radio-
button is selected, then 
the file is saved in Jpeg 
format

8 Quality Set the slider The parameter specifies 
the quality level of the 
exported file. The value 
of 100% results in no 
quality loss

% 80 0 to 100

The Compression group

9 Video Click the 
button

The button is for 
selecting and setting up 
the video codec used to 
compress video 
recordings. If the Native 
Archive radio-button is 
selected or the Native 
Format checkbox is 
checked, then this 
button is disabled

- -

1
0

Field next to 
the Video 
button

Not to be 
edited

The field shows the info 
on selected video codec. 
If the Native Archive
radio-button is selected, 
then this field is disabled

- Full Frame 
(Uncompr-
essed), 
Quality: 0

The list of codecs 
found by the utility

1
1

Audio Click the 
button

The button is for 
selecting and setting up 
the quality of the 
exported audio. The 
Native Archive radio-
button is selected, then 
this button is disabled

- - -
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N
o

Parameter 
name

Field type Description Form
at

Default value Value range

1
2

Field next to 
the Audio 
button

Not to be 
edited

The field shows the 
selected audio format

- PCM, 8000 
kHz; 16 bit; 
Mono

The list of quality 
levels detected

The Screen group

1
3

Overlay Checkbox If the Overlay checkbox 
is checked, there is 
DirectDraw conversion

- Checked Checked – use 
DirectDraw for 
conversion

Unchecked – do not 
use DirectDraw for 
conversion

1
4

Always On 
Top

Checkbox If the Always On Top
checkbox is checked, 
then Converter window 
is always over all other 
windows

- Unchecked Checked – the 
window is 
displayed on top

Unchecked – the 
window is not 
displayed on top

1
5

Keep Aspect 
Ratio

Checkbox If the Keep Aspect Ratio 
checkbox is checked, the 
aspect ratio of Converter
window is fixed

- Unchecked Checked – 3:2 ratio 
is kept when the 
size of the dialog 
box is changed

Unchecked – 3:2 
ratio is not kept 
when the size of the 
dialog box is 
changed

1
6

Split AVI files Checkbox Activates export of 
selected video 
recordings to the 
separate AVI files.

Note. If the checkbox is 
not checked, video 
recordings from one 
camera are exported to 
one AVI file

- Checked Checked - video 
recordings are 
exported to the 
separate AVI files

Unchecked – video 
recordings are 
exported to one AVI 
file
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N
o

Parameter 
name

Field type Description Form
at

Default value Value range

1
7

Digital 
signature

Checkbox Activates adding digital 
signature that is used for 
checking frame 
authenticity to exported 
frames.

Note. Checking frame 
authenticity is performed 
using SignCheck.exe 
utility (see The 
SignCheck.exe utility for 
checking the authenticity 
of exported frames and 
video recordings section)

- Unchecked Checked – digital 
signature is added

 Unchecked – 
digital signature is 
not added

If a microphone was selected as a device in the dialog box of Converter.exe utility, only the Audio button and the 
Screen group are enabled.

20.3.3 A dialog box for choosing the video codec
The Video button in the Export Setup dialog box opens a dialog box for choosing a video codec to be used for video 
compression.

N
o

Para
meter 
name

Field 
type

Description Form
at

Default 
value

Value range

1 Comp
ressor

Select 
from 
drop-
down 
list

The button allows selecting and setting up the 
video codec used to convert and compress the 
video image

Code
c 
name

Full 
frames 
(no 
compre
ssion)

All video 
codecs 
recognized by 
the operating 
system
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N
o

Para
meter 
name

Field 
type

Description Form
at

Default 
value

Value range

2 Comp
ressio
n 
qualit
y

Drag 
the 
slider

The slider allows setting the compression level. 
The zero position of the slider represents the 
highest compression and lowest quality. 
Changing this parameter is enabled if the codec 
is selected in the Compression Program field

% 0 0 to 100

3 Config
ure

Click 
the 
button

The button opens the settings panel of the video 
codec.  See the codec manual for details

- - -

4 About Click 
the 
button

The button opens an information box with 
codec details

- - -

20.3.4 A dialog box for choosing the audio format
The Sound button in the Export Setup dialog box opens a dialog box for choosing an audio format.

Note.

 If AVI format is used, the resultant file size should not exceed 2 GB.

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N
o

Parameter 
name

Field type Description Format Default 
value

Value range

1 Name Select from 
drop-down list

The field allows 
choosing the name 
for the selected audio 
format

Format 
name

Untitled Untitiled

CD Quality

Radio Quality

Telephone Quality

Compact disk

2 Format Select from 
drop-down list

The field for selecting 
the format

Format 
name

PCM The list of audio 
formats used by 
the utility

3 Attributes Select from 
drop-down list

The list of sound 
characteristics: 
playback/recording 
frequency (8000 kHz), 
digitizing level (8, 16, 
etc bits), channel type 
(mono/stereo)

Parame-ter 
values

PCM, 8000 
kHz, Mono

The list of 
characteristics, 
recognized by the 
operating system

4 Save as… Click the 
button

The button allows 
creating a unique 
name for the selected 
format. To save a 
format under a 
unique name:

1. Select Untitled in 
the Name field.

2. Select the values in 
the Format and 
Attributes fields.

3. Click the Save As
button

4. Enter a unique 
name in the Save 
This Format As field 
and click OK.

The newly created 
name will appear in 
the Name drop-down 
list. 

String - -
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8.

1.
2.

20.4 Using the Converter.exe utility

20.4.1 General description of the Converter.exe utility
The Converter.exe utility is designed to convert and play back audio and video recordings from the archive and save 
them to a specified folder.

Using the Converter.exe utility includes:

Starting the utility (see Starting and shutting-down the Converter.exe utility).
Selecting an archive (see Selecting an archive to be played or converted).
Finding a recording in the selected archive (see Selecting an archive to be played or converted).
Playback of the recording (see Recording playback).
Finding the required recording fragment or frame (see Searching for a video recording).
Setting the export or conversion parameters (see Converting video and audio archives to AVI files).
Exporting the fragment or printing the frame (see Exporting recordings and frames).
Shutting-down the Converter.exe utility (see Starting and shutting-down the Converter.exe utility).

20.4.2 Selecting an archive to be played or converted
To search an archive for a recording, do the following:

Select the device the recording was made by, and its number (1).
Click the Search button (2).
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3.

4.
5.

Select the location of the archive (folder with archives for specific date and time) on an appropriate disk.

Click the  button.
Specify the time limits in the date/time fields (3).

The first frame of the required recording will be displayed in the video playback screen.

20.4.3 Searching for a video recording
After the approximate time interval is selected using the date/time fields, and the required archive is found, it may 
be necessary to find a particular fragment or frame to be played or exported.

Note.

In case of searching for an audio recording, no visible signs of finding the recording will be shown. To 
check that a recording was found, play it.



Note.

Speed of records search directly depends on their number. The search process can take a lot of time if the 
archive depth is rather big and reading is performing from the network disk. 



•

•

Note.

If video files that are to be opened were not recorded, but copied, then start the Convert.exe utility to open 
the archive (see The Convert.exe utility for correcting modification dates of video archives section):

If the archive is created in the same time zone as it is viewed, then start the utility with the fullmode 
parameter:
convert.exe fullmode

If the archive is created in different time zone than it is viewed, then move the archive to the 
current time zone by starting the utility with the following parameters in the command prompt: 
convert.exe fullmode TZ +hh:mm 
where +hh:mm is the time shift between the current time zone and the time zone of the archive.

Otherwise, the folders with video files fail to open.


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1.

2.

3.

4.

5.

1.

2.

3.

1.

•

Searching for a fragment in a recording
To find the required video fragment in the selected recording, do the following:

Click the Play ( ) button in the playback control panel.

When the required fragment appears, click the Pause ( ) button.

Click the Fragment Start ( ) button to make the current frame the start of the fragment.

Click the Play ( ) button in the playback control panel.

When the required fragment ends, click the Fragment End ( ) button to make the current frame the end 
of the fragment. All subsequent frames will be omitted.

The resultant recording fragment will then be available for conversion or export, maintaining the format and the 
creation date.

Searching for a frame in a recording
To find a particular frame in the selected recording, do the following:

Click the Play ( ) button in the playback control panel.

When the required frame appears, click the Pause ( ) button to enter the per frame playback mode.

Keep clicking the Fragment Forward ( ) and Fragment Back ( ) buttons, to browse the frames 
until the required frame appears on the screen.

The resultant frame may be printed or used as a starting frame for a fragment (see Searching for a fragment in a 
recording section).

20.4.4 Recording playback
The recording selected by date and time, can be played in Converter.exe player using the playback control panel.

The panel contains five control buttons (left to right on the figure): Back, Play, Pause, Stop, Forward, allowing to 
play, pause, stop and browse the records.

If the Stop button is down (clicked), then it is possible to move between the recording segments by clicking 
the Forward or Back buttons. The recording segment means one of the following:

a segment of video recording between the commands to start and stop recording if the recording was 
initiated manually (for example, via a script or the camera's context menu);

Note.

If the recording is to be played back in the per frame playback mode starting with the first frame, 

then click the Pause ( ) button instead of the Play ( ) button.



Note.

To quit the per frame playback mode, click the Pause ( ) button once more.


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•

2.

3.

4.

5.

6.

1.
2.
3.

1.

a.
b.
c.

d.
e.

a segment of video recording between the beginning and the end of the detection tool triggering, 
taking into account the periods of pre- and post-recording in case the recording was initiated by any 
detection tool.

A short press of the Play button starts playing the recording segment from start to end. If the recording 
contains several recording segments, the Play button should be clicked to play each of them. 
To play a record consisting of several segments without stopping, press and hold the Play button for 1-2 

seconds. The button then changes its appearance from  to . To stop playback, click Stop.
To play the recording in the frame-by-frame mode: a) click Play, b) click Pause, c) keep clicking Forward or 
Back to view frames one by one.
To view the recording segment in accelerated mode click the Play button and then click the Forward to 
accelerate twice relatively the previous speed. The current playback speed is displayed in titles above video 
image.
To view the record section in slow motion, click the Play button and then click the Back to slow down twice 
relatively the previous speed. The current playback speed is displayed in titles above video image.

20.4.5 Converting video and audio archives to AVI files
Video and audio archives are converted into AVI format according to Converter.exe settings, using the Export Setup
dialog box. The level of compression of the exported recording is determined by the following parameters:

Frames Per Second parameter – setting the parameters of the recording grooming;
Video button – selection of the video codec, in case of video archive export;
Sound button – set the sound quality parameters (frequency, bitrate, etc), in case of audio archive export.

20.4.6 Exporting recordings and frames
Export of the recordings is one of the main functions of the Converter.exe utility. There are two ways of exporting 
records from an archive:

Export to AVI option converts (compresses) a recording and breaks it down into volumes (files of the size 
specified in the Export Setup dialog box).
To export the recording as AVI, do the following:

Find the recording in an archive (see the Selecting an archive to be played or converted section).
In the Export Setup dialog box, select the Export to AVI radio-button.
Click the Video or Sound button to specify the conversion parameters. Click the OK button.

Click the Export to AVI/Archive button ( ) to start exporting.
Enter the name of the device folder to save the recording to (1), then click Continue ( 2).

The export progress will be shown in the title bar of the Converter.exe window.

Note.

 If AVI format is used, the resultant file size should not exceed 2 GB.

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c.

The title bar will read Complete, when exporting is completed. To verify the results, open the Backup 
folder and find the file named after the device from which archive the recording was exported.

The Export to Archive option allows copying the files from an archive to another location on the disk with no 
conversion, maintaining the recording creation date and an option for breaking it down into volumes.
To export a recording in the same format as it is stored in the archive, do the following:

Find the recording in the archive (see the Selecting an archive to be played or converted section).
In the Export Setup dialog box, select the Export to Archive radio-button.
Specify volume size in the Export Setup dialog box. Click the OK button.

Click the Export to AVI/Archive button ( ) to start exporting.

The Converter.exe utility allows exporting frames into bitmap and JPEG formats. Do the following:

Find the required frame (see the Searching for a frame in a recording section).
In the Export Setup dialog box, specify the parameter values in the Frame Export group. Click the 
OK button.

Click the Export Frame button ( ).

Note.

 If AVI format is used, the resultant file size should not exceed 2 GB.

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d.
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Specify the location to save the exported file to in the Save As dialog window.

The file name will be generated automatically in the following format: 1) name and number of the 
camera where the frame comes from; 2) creation date; 3) creation time. The file extension 
corresponds to the file format selected in the Export Setup dialog box.
Click the Save button.

20.4.7 Using a command prompt to work with the Converter.exe utility
Video and frames can be exported with the help of a command prompt using the following commands:

Converter.exe Disc:\File,Number_Cam,StartDate StartTime,StopDate StopTime,CameraName

Converter.exe Disc:\File,Number_Cam,StartDate StartTime,,CameraName

The table describes the command parameters.

Parameter Description

Disk Disk for storing exported files

Note.

If StopDate and StopTime parameters are not specified, then ‘,’ is to be specified instead.

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File Name of a catalogue or file.

Note 1. If the catalogue or file specified in the command does not exist, it will 
be created automatically.

Note 2. To export archive (video record in the original format) only catalogue 
name is to be specified.

Number_Cam Number of a camera which performs the recording

StartDate Date of record start (dd-mm-yy)

StartTime Time of record start (hh:mm:ss)

StopDate Date of record end (dd-mm-yy).

Note. Parameter is not in use while exporting the separate frames

StopTime Time of record end (hh:mm:ss)

Note. Parameter is not in use while exporting the separate frames

CameraName Name of the camera that is to be displayed in the titles on the exported 
video, as well as the name of the folder created in the specified export folder 
used for storing exported files

The example of using the command prompt to export files is shown in the figure.

As a result the “export” folder containing the exported files is created on the local disk “C”.
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20.4.8 Printing a frame
To print a frame, do the following:

Find the required frame (see the Searching for a frame in a recording section).

Click the Print Frame button ( ).
A standard dialog box for printing and printer setup will be opened.

20.4.9 Exporting video with titles
Video with titles is exported as follows:

Run the Converter.exe utility (see Starting and shutting-down the Converter.exe utility).
Call for Export Settings dialog window in the opened window of Converter.exe utility and set its groups 
Choose folder, Frame Export, Compression and Screen (see. Interface description of The Export Settings 
dialog box).
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3. Set the titles displaying in the Titles group in the dialog window Export Settings; table shows parameters 
description of the given.

№ Parameter name Parameter description Value range

1 Point of sale 
dropdown list

Name of cash terminal, titles from 
which should be laid over the video 
recording while viewing and 
exporting the frames and recordings 
with the help of Converter.exe utility

Empty value – titles from all the 
titrates overlay function.
No – overlay function is off.
Number of cash terminal (from 
one and above) – function of 
displaying the titles concerning 
the given cash terminal.

2 Checkbox Name, 
Date, Time

When the given checkbox is 
activated, lines, containing name 
and number of a camera, date and 
time of creation of the given video 
frame, will be laid over the video 
recording

Yes – lines, containing name and 
number of a camera, date and 
time of creation of the given video 
frame , will be laid over the video 
recording.
No – lines, containing name and 
number of a camera, date and 
time of creation of the given video 
frame , will not be laid over the 
video recording.
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3 Editing text fields X, Y, 
W, H

Coordinates and area size, taken by 
titles in the video recording. Is 
expressed in percentage relative to 
the screen size of video recording 
playback

From 0 and above.
Depends on the screen size of 
video recording playback.

4 Font button Font selection of titles displaying -

To apply the settings it is necessary to click OK button. To cancel settings one should click the cross mark in 
the upper right corner of Export Settings dialog window.
Dialog window of Converter.exe utility for exporting the required file will open in result (see Exporting 
recordings and frames).

Export of video recordings with titles is completed.

Note.

 If the cash terminal is selected, its value will not be saved with the repeated run of Converter.exe 
utility. On default displaying titles from all the titers is set.


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21 Tweaki.exe utility for advanced setup of the Axxon PSIM 
software system

21.1 The purpose of the tweaki.exe utility
The tweaki.exe utility is used for configuring Axxon PSIM by editing the sections of the Windows registry, where the 
setup parameters for the Axxon PSIM core and modules are stored:

For 64-bit systems, the sections are HKLM\SOFTWARE\Wow6432Node\AxxonSoft and 
HKCU\SOFTWARE\Wow6432Node\AxxonSoft.
For 32-bit systems, the sections are HKLM\SOFTWARE\AxxonSoft and HKCU\SOFTWARE\AxxonSoft.

The utility should be run as the same Windows user who is used to start Axxon PSIM, otherwise the new settings may 
not apply. This is because the choice of the Windows account determines to which registry section the changes will 
be written.

The tweaki.exe utility provides the following functionality:

Setup of Axxon PSIM startup (see The Settings panel of the Windows section);
Enabling the debug mode of Axxon PSIM (see Enabling and configuring the debug mode of Axxon PSIM 
software);
Advanced setting of the Video surveillance monitor (see The Settings panel of the Video subsystem section);
Advanced setting of events logging (see The Settings panel of the Axxon PSIM section);
Advanced setting of video signal processing by Server (see The Settings panel of the Video subsystem 
section);
Advanced setting of distributed architecture (see Extended setup of the distributed architecture);
Changing network names and IP-addresses in the configuration database (see Changing computer names 
and IP addresses in the Axxon PSIM configuration database);
Limiting the RAM used by MS SQL server (see Limiting memory usage by an MS SQL server);
Advanced setting of audio or video recording to an archive (see The Settings panel of the Video subsystem 
section);
Re-indexing audio and video archives (see Re-indexing the audio and video recordings archive);
Selecting the analog video output operation mode The Settings panel of the Video subsystem section);
Testing the operability of video capture cards (see Testing video capture cards);
Advanced setting of PTZ devices (see The Settings panel of the PTZ section);
Advanced setting of POS PSIM (see The Settings panel of the POS PSIM section);
Displaying versions of Axxon PSIM modules (see The Settings panel of the Version section).

21.2 Starting and shutting-down the Tweaki.exe utility
To start the tweaki.exe utility, do one of the following:

Start the utility from the Windows taskbar. Click Start => All Programs => Axxon PSIM => Tools => 
Advanced settings utility. The tweaki.exe utility is available from the Start menu with the following 
installation types of Axxon PSIM: Server, Remote administrator workstation, Remote client.
Start the utility from the Tools folder of the Axxon PSIM program folder: C:\Axxon PSIM\Tools\Tweaki.exe.

The Axxon PSIM Advanced Setup dialog box appears after running the tweaki.exe utility.

Attention!

Invalid values of the registry keys may lead to the system failure.

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1.
2.

To shutdown the tweaki.exe utility and save the changes click OK. To shutdown the tweaki.exe utility without 
saving the changes, click  .

21.3 Interface of the Tweaki.exe utility
The user interface of the tweaki.exe utility consists of two interrelated elements:

Tree of sections (1).
Settings panel for each section (2).
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Sections tree of the tweaki.exe dialog box has static structure and is used for navigation in the utility. To access the 
settings panel for the required section, left-click the corresponding tree tab.

21.3.1 The Settings panel of the Windows section
The Windows section is used to set Windows running Windows OS. The settings panel for the Windows section is 
shown in the figure.
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The parameters of the Windows setting panel are described in the table.

N
o

Parameter 
name

Field type Description Represen
tation

Default 
value

Value range

The Shell group

1 The Explorer/
File switch

Set in the 
position

Selection of Windows 
working shell

Attention! Disable UAC 
to run the Axxon PSIM 
software package as 
the shell. Configuration 
of the local security 
policy is required for 
full disabling of UAC in 
the Windows 8 and 
Windows 8.1 OS – see 
OS settings for correct 
operation of Remote 
Admin Workstation or 
Server

- Explorer Explorer – Microsoft 
Explorer is loaded as 
working Windows 
OS shell 
(corresponds to 
standard Windows 
OS settings).

File – Axxon PSIM
starts as a working 
shell of Windows OS

https://docs.axxonsoft.com/confluence/display/PSIM100en/OS+settings+for+correct+operation+of+Remote+Admin+Workstation+or+Server
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N
o

Parameter 
name

Field type Description Represen
tation

Default 
value

Value range

2 The File field 

with 
button. Active 
for the File
switch 
position

Button is 
pressed

Opens standard 
Windows window 
«Open» to select shell 
file of OS Windows. 
Full path to the file is 
displayed in the field

- - The psim.exe or 
psim_host.exe 
executive file is 
selected as a shell

The Autologon group

3 The Enable
checkbox

Checkbox Activates automatic 
log on of the user to 
OS Windows

Boolean 
type

No Yes – automatic log 
on of the user is 
activated

No – automatic log 
on of the user is not 
activated

4 The 
Username
field

Type-in the 
value

Set the username for 
logging on the OS 
Windows

- - Up to 64 characters. 
Depends on the 
settings of Windows 
user account (stored 
locally or on domain 
server)

5 The Password
field

Type-in the 
value

Set the password for 
logging on the OS 
Windows

- - 8 to 14 characters

Depends on the 
settings of Window’s 
user account (stored 
locally or on domain 
server)

6 The Domain
field

Automatical
ly

Displays the name of 
domain server (if there 
is any), where data  
concerning user 
account is stored (user 
name and password)

- - Depends on domain 
net settings (net 
settings of OS 
Windows 
correspondingly)
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N
o

Parameter 
name

Field type Description Represen
tation

Default 
value

Value range

7 Restart Axxon 
PSIM on user 
login
checkbox

Setting 
checkbox

Specifies the way of 
restart the Axxon PSIM
software installed as a 
service on user login

Boolean 
type

Yes Yes – the Axxon PSIM
software installed as 
a service restarts 
under the current 
user if it belongs to 
the PSIM Users 
group

No – The Axxon PSIM
software installed as 
a service doesn't 
restart under the 
current user even for 
users belonging to 
the PSIM Users 
group

21.3.2 The Settings panel of the Axxon PSIM section
The Axxon PSIM section is used for Axxon PSIM advanced setup. The settings panel for the Axxon PSIM section is 
shown in the figure.
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The parameters of the Axxon PSIM settings panel are described in the table.

N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

1 The Core IP 
address
field with 

button. Is set 
on the Client

Type-in the 
value in the 
field/use the 

 button

Set the IP address 
of the Axxon PSIM
server to which the 
psim_host.exe 
module is 
connected by 
default. 
In case of pressing 

 button, IP 
address of the local 
computer is set

IP address 127.0.0.1 Depends on net 
settings of the 
Server. In case of 
connection failure 
dialog window 
requiring IP address 
is displayed
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

2 Keyboard 
prefix 

Type-in the 
value in the 
field

Set the prefix for a 
special keyboard. 
When a button is 
pressed on this 
key-board the 
Axxon PSIM detects 
when the button 
was pressed on this 
very keyboard

Symbol - Usually, a tilde (~), 
code 126

The Logging subsystem group
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

3 Debug 
mode 

Dropdown list Set the mode of the 
Axxon PSIM Debug 
window displaying

List of 
available 
modes of 
Debug 
window
displaying

None Disabled – Debug 
window is not 
displayed

Debug 1 – Debug 
window is 
displayed  and a 
log-file containing 
recordings about 
modules errors is 
created

Debug 2 – Debug 
window is 
displayed and a log-
file containing 
recordings about 
modules errors and 
alerts is created

Debug 3 – Debug 
window is 
displayed and a log-
file containing 
recordings about all 
the modules events 
is created

Debug 4 – Debug 
window is 
displayed and a log-
file containing 
recordings about all 
the modules events, 
and also additional 
menu that is 
individual for each 
module (used by 
programmers) are 
created

4 Log-storing 
time (hours)

Type-in the 
value in the 
field

Set the time of 
keeping log files

Sequence 48 hours > 0
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

5 Counters 
logging 
time (sec)

Type-in the 
value in the 
field

Assigns the time 
interval in seconds 
for logging 
processor load, 
memory usage, 
and disk usage

Sequence 60 Positive whole 
numbers not less 
than 60 and zero. If 
the value 0 is 
specified, sensor 
data is not included 
in the log file

6 Save logs Checkbox Enables logs saving Boolean 
type

Yes Yes – logs are saved

No – logs are not 
saved

7 Redirect to 
debugger

Checkbox Enables the 
debugger

Boolean 
type

None Yes – the debugger 
is in use

No – the debugger 
is not in use

8 Maximum 
size (MB)

Type-in the 
value in the 
field

Defines the 
maximum size of 
RAM that log files 
can use. Log files 
are archived after 
that size is reached

Sequence 100 MB >= 100

Values less than 100 
Mb are ignored

The JPG and AVI files export path group

9 The Default 
(Axxon 
PSIM\Exp-
ort)/Other
switch

Set in the 
position

Set the folder for 
exported files from 
Axxon PSIM video 
archive

- Default 
(Axxon 
PSIM\Expor
t)

Default (Axxon 
PSIM\Export) – 
exported to the C:
\Users\%current 
user name%
\Documents\Axxon 
PSIM\export\ folder

Other – exported to 
the selected folder

1
0

The Other
field with 

the 
button

Click the 
button/type-
in the value in 
the field

Set the pathname 
to the folder, where 
files from video 
archive are to be 
exported when the 
switch is set in the 
Other position

Pathname - -
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

1
1

Open folder Click the 
button

Opens the current 
folder to export 
the  files

- - -

1
2

Record path Checkbox The checkbox 
forbids export 
catalogue change 
while exporting the 
archive period as 
well as exporting 
the archive from 
AviExport utility

Boolean 
type

No Yes – export 
catalogue change is 
forbidden

No – export 
catalogue change is 
allowed

No group

1
3

Receive 
uncompress
ed video

Checkbox Enables receiving 
uncompressed 
video from the 
Server. As a rule is 
set on the Client

Boolean 
type

No Yes – Client receives 
uncompressed 
video from the 
Server

No – Client receives 
compressed video 
from the Server

1
4

Event 
viewer over 
all windows

Checkbox Enable displaying 
the Event viewer 
window over all 
windows

Boolean 
type

No Yes – the Event 
viewer window is 
displayed over all 
windows

No – the Event 
viewer  window is 
displayed if a 
corresponding 
screen is selected
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

1
5

Only local 
protocol

Checkbox Enables logging the 
events registered in 
the given computer 
to the Events 
protocol database.

Note. This 
parameter can be 
set on the settings 
panel of the 
Computer object – 
see Configuring 
events logging
section

Boolean 
type

No Yes – events 
registered in the 
given computer are 
recorded to the 
Events protocol 
database

No – all required 
events are recorded 
to the Events 
protocol database

1
6

Sort tree 
objects by 
ID

Checkbox Enables sorting of 
objects in the tree 
by identifier.

Note 1. If sorting by 
name is chosen, 
and there are 
numbers in the 
object name, then 
the objects will be 
sorted in 
alphabetical order. 
For example, an 
object with the 
name "115" will be 
above the object 
with the name "15", 
because in the 
name "115" the 
second number is 1, 
and in the name 
"15" the second 
number is 5.

Note 2. This key 
also affects the 
sorting of objects in 
the tree when 
adding the objects 
to a layer in the 
Map Editor utility

Boolean 
type

No Yes – objects in the 
tree are sorted by 
identifier

No – objects in the 
tree are sorted by 
name

https://docs.axxonsoft.com/confluence/display/PSIM100en/Configuring+events+logging
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

1
7

Disable 
protocol

Checkbox Disables events 
logging to the 
Event viewer 
database on this 
computer.

Note. This 
parameter can be 
set on the settings 
panel of the 
Computer object – 
see Configuring 
events logging
section

Boolean 
type

No Yes – events are not 
logged to the Event 
viewer database

No – events are 
logged to the Event 
viewer database

1
8

Used 
memory 
dump

Checkbox Enables 
logging .dmp file 
with a copy of main 
memory with 
incorrect shutting 
down at least one 
of the system 
modules to the 
Axxon PSIM root 
folder

Boolean 
type

No Yes – memory 
dump is created

No – memory dump 
is not created

1
9

Support old 
scripts

Checkbox Set the support of 
program tools in 
Axxon PSIM

Boolean 
type

No Yes – both scripts 
and programs are 
supported

No – only scripts are 
supported

https://docs.axxonsoft.com/confluence/display/PSIM100en/Configuring+events+logging
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

2
0

Time 
synchroniza
tion

Checkbox Set time 
synchronization of 
all computers in 
the distributed 
system with system 
time of this 
computer. Time is 
automatically 
synchronized at 
midnight every 24 
hours or when 
Axxon PSIM is 
started on the 
Server that is the 
source of time 
synchronization

Boolean 
type

No Yes – 
synchronization is 
enabled

No – 
synchronization is 
disabled

2
1

Overlay in 
Event 
protocol

Dropdown list Set the overlay 
mode for 
processing the 
video signals that 
can be viewed with 
the help of the 
Event protocol 
object

Names of 
overlay 
modes

Overlay 2 None – video 
signals are not 
processed by video 
card

Overlay 1 – 
Direct3D is used

Overlay 2 – 
DirectDraw is used

2
2

Application 
language

Dropdown list Assigns the Axxon 
PSIM Software 
System's interface 
language

Names of 
installed 
languages

- Depends on the set 
of installed 
languages. 
See Axxon PSIM 
Software System's 
interface language

The Settings panel of the DNS section
The DNS section is used for setting the automatic connection between the Client and reserve Servers in case of 
connection loss with the main Server. In the DNS section it is necessary to specify netnames and IP-addresses of 
reserve Servers as they are not listed in the Windows registry by default.

The settings panel for the DNS section is shown in the figure.

https://docs.axxonsoft.com/confluence/display/PSIM100en/Axxon+PSIM+Software+System%27s+interface+language
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The parameters of the DNS settings panel are described in the table.

№ Parameter 
name

Field type Description Represent
ation

Default 
value

Value range

1 The System 
identifier
column

Type-in the 
value in the 
field

Set  the netname of 
the reserve video 
Server if the 
connection with 
main Server is lost

- -  Depends on net 
settings of 
reserve video 
server

2 The IP-
address
column

Type-in the 
value in the 
field.

Set the IP-address of 
the selected reserve 
video Server

IP-address - Depends on net 
settings of 
reserve video 
Server
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№ Parameter 
name

Field type Description Represent
ation

Default 
value

Value range

3 The Allow 
all names
button

Click the 
button

Computer’s IP-
addresses, set in the 
System identifier
column, are 
automatically added 
to the IP-address
column, if  these 
addresses are 
enabled and 
identified

- - -

The Settings panel of the Visitor management system section
The Visitor management system section is designed for creating common photo database of the Access 
Manager module (is not included into Axxon PSIM base configuration, see Creating a single photograph database). 
In this section it is necessary to specify netnames of computer where the photos are to be stored. Photos are to be 
stored in the Person folder (<Axxon PSIM>\Bmp\Person).

Note.

The Person folder is automatically created when the Access Manager module is installed.


https://docs.axxonsoft.com/confluence/display/acfaPSIM100en/Creating+a+single+photograph+database


PSIM 1.0.0-1.0.1 (english) – Additional Utilities for the Axxon PSIM Software

Tweaki.exe utility for advanced setup of the Axxon PSIM software system– 68

The Settings panel of the Distributed configuration section
The Distributed configuration section is for Axxon PSIM common database adjustment when real computer 
netnames do not coincide with the names in the database (for instance when the computer with the database is 
replaced). The section is also used for adjusting IP-address of selected computer in the database.

The settings panel for the Distributed configuration section is shown in the figure.

The parameters of the settings panel are described in the table.

№ Parameter 
name

Field type Description Representatio
n

Default 
value

Value range

1 The Select 
database
button

Click the button Opens the 
standard Data 
Link Properties
dialog box to 
choose the 
database, where 
netname and/or 
IP-address are to 
be changed.

- - -
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№ Parameter 
name

Field type Description Representatio
n

Default 
value

Value range

2 The Use 
current DB
button

Click the button Selection of 
main Axxon PSIM
database 

3 The 
Available 
systems
table

Automatically Displays the list 
of netnames of 
computers that 
are in selected 
database

- - Netnames of 
computers 
connections 
between which are 
set on the 
Architecture tab

4 The New 
system ID 
field with 

 button

Button is clicked 
and value is 
selected from 
the list/ typed in 
the field.

Specifies a new 
netname of a 
computer 
selected in the 
Available 
systems table

- - Depends on the 
current net 
settings of the 
required 
computer.

If the network 
name is longer 
than 15 
characters, then 
first 15 characters 
are to be specified 
as the network 
name in this field

5 The Update 
protocol
checkbox

Checkbox Replaces the 
computer’s 
netname in the 
Events protocol
table of the 
selected main 
Axxon PSIM 
database

Boolean type None Yes – computer’s 
netname is 
replaced in the 
Events protocol
table

No – computer’s 
netname is not 
replaced in the 
Events protocol
table



PSIM 1.0.0-1.0.1 (english) – Additional Utilities for the Axxon PSIM Software

Tweaki.exe utility for advanced setup of the Axxon PSIM software system– 70

№ Parameter 
name

Field type Description Representatio
n

Default 
value

Value range

6 The Clear 
protocol
checkbox

Checkbox Clears the event 
log from the 
Events protocol
table of the 
selected main 
Axxon PSIM
database

Boolean type None No – the list of 
registered events 
is not cleared

Checked – the list 
of registered 
events is cleared

7 The Update 
DB button

Click the button Runs  the 
process of 
updating the 
selected 
database in 
accordance with 
given settings

- - -

8 The Update 
protocol
field

Automatically Displays 
updating process 
of the selected 
database

- - Depends on the 
structure of the 
selected database 
and the given 
settings

The Change IP address group

9 The 
dropdown 
list with IP-
addresses

Select from the 
list

Specifies IP-
address that is to 
be changed  in 
the selected 
database

IP-addresses of 
 computers in 
the selected 
database

- Depends on the 
number of 
computers 
connections 
between which are 
set on the 
Architecture tab

10 Field of 
setting IP-
address

Type-in the 
value in the field

Specifies a new 
IP-address to be 
changed in the 
selected 
database

IP-address 127.0.0.1 Depends on the 
current net 
settings of the 
required computer
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№ Parameter 
name

Field type Description Representatio
n

Default 
value

Value range

11 The Edit 
button

Click the button Changes the IP-
address of the 
required 
computer in the 
selected 
database

- - -

The Settings panel of the MSDE (MS SQL) configuration section
The MSDE (MS SQL) configuration section is designed for setting the limits of RAM space for MS SQL Server 
operation with databases of SQL format. This limitation enhances the performance of the system.

The settings panel for the MSDE (MS SQL) configuration section is shown in the figure.

The parameters of the settings panel are described in the table.
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№ Parameter 
name

Field type Description Representation Default 
value

Value range

1 The Select 
database
button

Click the 
button

Opens the standard 
Data Link 
Properties dialog 
box for choosing 
the database of MS 
SQL format the 
RAM space for 
which is to be 
limited.

- - -

2 The Use 
current DB
button

Click the 
button

Selects the main 
Axxon PSIM 
database

- - -

3 The 
Maximum 
memory 
usage (MB)
indicator

Enter the 
value in the 
field

Sets the space of 
RAM in MB for SQL 
Server operation

MB 4096 Depends on full 
space of RAM.

4 The SQL 
database 
size field

Automaticall
y

Displays the 
current size of all 
MS SQL databases 
on the Server

Positive real 
number with 
amount 
precision − two 
decimals

- Depends on the 
capacity 
of storage 
where the 
database is.

21.3.3 The Settings panel of the Video subsystem section
The Video subsystem section is designed for advanced setup of the video subsystem in order to enhance the 
performance of Axxon PSIM.

The settings panel for the Video subsystem section is shown in the figure.
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The parameters of the settings panel are described in the table.
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

1 The Ring
field

Enter the value 
in the field

Sets free disk space; 
when the limit is 
reached the earliest 
recordings will be 
deleted on loop 
(see General 
information on 
video archiving). If 2 
or more disks are in 
use for video 
archiving, archiving 
on current disk is 
performed till there 
is FreeMbCritical of 
free disk space 
(1000 Mb by default, 
see the info on the 
key in Registry keys 
reference guide).

Free space set by 
the Ring parameter 
is used for 
recording 
temporary files. 
This means that 
when the limit set 
by the Ring 
parameter is 
reached, the 
maximum size of 
the temporary file is 
Ring (registry key 
FreeMb). Video can 
contain less frames 
than set by the 
Frame count
parameter.

Note. Old recordings 
may get deleted 
before the 
remaining disk 
space reaches the 
specified value if the 
disk space is less 
than 15000

MB 5000 Depends on the disk 
space

https://docs.axxonsoft.com/confluence/display/PSIM100en/General+information+on+video+archiving
https://docs.axxonsoft.com/confluence/display/PSIM100en/Registry+keys+reference+guide
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

2 The Frame 
count field

Enter the value 
in the field

Sets the maximum 
number of frames in 
one recording file

Frame 1500 1500 to 10000. It is 
not recommended to 
change the default 
value

3 The 
Recording 
time list

Enter the value 
in the field / 
select from the 
list

Sets the length of 
the file in seconds, 
restricting 
fragment’s size not 
by number of 
frames but by time 
of its recording

Time in sec 0 Unlimited

4 The Record 
restart 
when 
entering 
the archive 
checkbox

Enter the value 
in the field / 
select from the 
list

Enables restarting 
record on archive 
entering

Integer No 0 – patch that has 
been recorded on 
archive entering is 
stopped and a new 
one starts. As a result 
the user who enters 
the archive sees a 
freeze frame 
corresponding to that 
on exiting

>0 – the recording is 
restarted when 
entering the archive, 
while positioning in 
the archive is carried 
out with a shift back 
to the specified value 
in seconds

-1 – recording is not 
stopped on archive 
entering

5 The Rebuild 
index button

Click the 
button

Deletes the 
database index file. 
After deleting the 
index, restart Axxon 
PSIM for a new 
index to be created

- - -
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

6 The Priority 
dropdown 
list

Select the 
value from the 
list

Sets the priority of 
all Axxon PSIM video 
system processes

Names of 
priority 
processes

Below 
normal

Realtime, High, 
Above normal, 
Normal, Below 
normal, Low

7 The Analog 
video 
output drop-
down list

Select the 
value from the 
list

Selects analog 
output operation 
mode

Names of 
available 
modes

All All – video signals 
from all the analog 
outputs are displayed 
on one screen

One – video signal 
from one analog 
output is displayed 
on one screen

8 The Use 
virtual 
grabber
checkbox

Set the 
checkbox

Allows access to 
virtual Video 
Capture Devices
settings (grabber) in 
Axxon PSIM.

Note. Desktop 
Experience Feature 
is to be enabled 
when using a virtual 
video capture device 
on server OS and avi 
files

Boolean 
type

No Yes – the Virtual
value is available 
from the Type drop-
down list on the 
settings panel of the 
Video Capture 
Device objects

No – the Virtual value 
is not available for 
the Video Capture 
Device objects

9 The Hide 
mask
checkbox

Set the 
checkbox

Prohibits displaying 
video hidden with 
the motion detector 
mask. Video area 
marked with 
motion detector 
mask will be grey-
filled. This feature 
supports only 
uncompressed 
video from FS or FX 
video capture cards

Boolean 
type

No No – video hidden 
with the mask is 
displayed

Yes – video hidden 
with the mask video 
is not displayed
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N
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Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

1
0

The 
Automatic 
font size 
selection for 
export
checkbox

Set the 
checkbox

Enables the relative 
font size for 
captions (camera 
No. and time) when 
exporting a frame 
or fragments of the 
video archive

Boolean 
type

No No – when exporting 
a frame, regardless of 
the video resolution, 
the caption size 
remains constant as 
set by the 
SubtitlesFontSize 
registry key, see 
the Registry keys 
reference guide.

Yes – when exporting 
a frame, the caption 
size is scaled 
depending on the 
video resolution.

1
1

The Gradual 
increment 
of camera 
tile
checkbox

Set the 
checkbox

Enables a gradual 
increase of the 
Video Surveillance 
window on the 
custom layout by 
double-clicking the 
left mouse button. 
All Video 
surveillance 
windows on the 
layout should be 
the same size to 
ensure proper 
operation of the key

Boolean 
type

No No – the Video 
surveillance window 
is expanded to the 
entire Video 
surveillance monitor 
by double-clicking 
the left mouse 
button.

Yes – by double-
clicking the left 
mouse button, the 
Video Surveillance 
Window is enlarged 
gradually: the first 
double-click enlarges 
it 2 times of the initial 
size, the second 
double click enlarges 
3 times of the initial 
size, etc. The Video 
Surveillance 
Windows adjacent to 
it are hidden on the 
layout.

https://docs.axxonsoft.com/confluence/display/PSIM100en/Registry+keys+reference+guide
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

1
2

The Swap 
frame fields
checkbox

Set the 
checkbox

Switches Axxon 
PSIM from basic to 
additional driver if 
there are video 
artifacts while using 
basic driver

Boolean 
type

No No –  Axxon PSIM
operates with basic 
driver

Yes – Axxon PSIM
operates with 
additional driver

1
3

The Use 
PureVideo/
CUDA 
hardware 
acceleration
checkbox

Set the 
checkbox

Enables PureVideo/
CUDA support on 
the Server while 
decompressing 
video from IP 
devices if PureVideo 
HD card of the 2nd

or 3rd generation 
(NVIDIA VP2 and 
VP3) is installed. 
Used to reduce 
Server load due to 
resources of 
graphics processor

Boolean 
type

Yes No – PureVideo/CUDA 
is not in use

Yes – PureVideo/
CUDA is in use

1
4

The Pause 
playback at 
archive 
entry 
checkbox

Set the 
checkbox

The Pause button is 
pressed on archive 
entering

Boolean 
type

No Yes – the Pause
button is pressed on 
archive entering, 
archive navigation 
using arrow keys

No – the Pause 
button is not pressed 
on archive entering

1
5

The Step of 
digital zoom 
scale field

Enter the value 
in the field / 
select the 
value from the 
list

Specifies the  
fractional step of 
video image 
zooming

Real 
numbers 
with the 
fixed point

2,00 Maximum value 
depends on the 
maximum scale of 
digital zoom (see. 
№17).

Minimum value is 
1,00

1
6

The 
Maximum 
scale of 
digital zoom
field

Enter the value 
in the field / 
select the 
value from the 
list

Specifies the 
maximum value of 
digital zoom of 
video image

Numbers 16 1-16
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N
o

Parameter 
name

Field type Description Representa
tion

Default 
value

Value range

1
7

The Camera 
without 
video 
compressio
n table

Enter the value 
in the field

Specifies the 
numbers of 
cameras connected 
to the video capture 
cards with 
compression. There 
is no compression 
for these cameras, 
i.e. the compressor 
settings in Axxon 
PSIM are ignored

Camera’s 
serial 
number

- Depends on the 
number of cameras 
registered in the 
system

 

21.3.4 The Settings panel of the Testing video capture cards section
The Testing video capture cards section is designed to test the connection of the cameras to the video capture 
card.

The settings panel for the Testing video capture cards section is shown in the figure.

Note

 Setting the non-zero value to the Recording time parameter does not exclude the Frame count
parameter. If the values for both parameters are set, then the file recording will be performed in 
accordance with the value which comes first. For instance, if the value of Recording time is equal to 10 
seconds and Frame count is equal to 500 frames (by default) and in ten seconds the fragment consists of 
80 frames, then 80-frame file is recorded. 



Note.

To use this functionality Axxon PSIM is to be logged off. Otherwise there is “Cards not found” message.

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The parameters of the settings panel are described in the table.

N
o

Param
eter 
name

Field 
type

Description Represent
ation

Defaul
t 
value

Value range

1 The 
Board 
dropd
own
list

Dropd
own 
list

Specifies the video capture card 
which camera connections are to be 
checked

List of 
video 
capture 
cards

- Depends on the 
number of installed 
video capture cards

2 The 
Test 
butt
on

Click 
the 
button

Starts the testing process of the 
video capture card. The Axxon PSIM
system is to be closed at the time of 
testing.

- - -

The Channels state table

3 The 
Chann
el
colum
n

Autom
atically

Displays the channels numbers of the 
selected video capture card

- - From 1 to 16
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N
o

Param
eter 
name

Field 
type

Description Represent
ation

Defaul
t 
value

Value range

4 The 
State
colum
n

Autom
atically

Displays the state of camera 
connections to the channels of the 
selected video capture cards

Attach – camera is 
attached

Detach – camera is 
detached

21.3.5 The Settings panel of the PTZ section
The PTZ section is used for setting the telemetry control elements.

The settings panel for the PTZ  section is shown in the figure.

The parameters of the PTZ  settings panel are described in the table.
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N
o

Parameter 
name

Field type Description Representati
on

Default 
value

Value range

1 The Delay 
between 
commands 
(ms) field

Type-in the 
value

Sets  the delay time 
between executing the 
commands for PTZ 
devices

This parameter is not 
supported by IP 
cameras.

ms 250 No limitations. It 
is not 
recommended to 
change the 
default value.

2 The Delay by 
priority (ms)
field

Type-in the 
value

Sets the delay time 
before switch from the 
PTZ control to a user 
with lower or equal 
priority.

ms 30000 No limitations. It 
is not 
recommended to 
change the 
default value.

The Joystick group

3 The
Sensitivity 
 (1-10) field

Enter the 
value in the 
field

Sets sensitivity of the 
joystick: the less value 
the more sensitivity. If 
value of parameter is 
small then camera will 
react on even small 
deviations of the 
joystick. If value of 
parameter is great the 
camera will stay fixed 
until significant 
deviation  of joystick

Sensitivity in 
conditional 
units

5 1-10

21.3.6 The Settings panel of the POS PSIM section
The POS section is designed for setting the POS PSIM module for controlling cashier operations (is not included in 
Axxon PSIM basic version). Detailed information about POS PSIM configuring using the tweaki.exe utility is presented 
in The settings panel for the POS sections using the tweaki.exe utility section in the Administrator's Guide 
documentation for POS PSIM software package.

https://docs.axxonsoft.com/confluence/display/posPSIM100en/The+settings+panel+for+the+POS+sections+using+the+tweaki.exe+utility
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21.3.7 The Settings panel of the Version section
The Version section provides information about Axxon PSIM software modules: versions, paths to executable files 
and .dll libraries, file sizes and dates of creation and modification.

The settings panel for the Version section is shown in the figure.
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•
•

21.4 Typical tasks concerning system extended settings

21.4.1 Enabling and configuring the debug mode of Axxon PSIM software

On the page:

Enabling debug mode
Configuring log file parameters

Debug mode is a special operation mode when the Debug window is open, and is designed for analyzing the 
progress of Axxon PSIM software operation and for prompt debugging in case errors occur. Log files are created in 
this mode—they are stored on the disk for a specific time period. 
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1.
2.
3.
4.

5.
6.

7.

Enabling debug mode
By default, debug mode is disabled. To enable debug mode, do the following:

Shut down Axxon PSIM.
Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility)
Select the Axxon PSIM node in the tree on the left side of the utility dialog box.
Change the parameter Debug Mode from None to Debug 1, Debug 2, Debug 3 or Debug 4 (see description 
of modes in The Settings panel of the Windows section).
Click the OK button.
Start Axxon PSIM.
The Debug window item will appear in the Axxon PSIM main control menu.

Select Debug window in the main control menu to open the Debug window. The selected item will be 
marked with a tick.

To hide the Debug window, select the Debug window item in the menu once more.

Note

The debug mode slows the system down and uses a lot of system resources. We strongly recommend to 
enable debug mode for debugging purposes only and to disable it when all the settings are completed.


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1.

2.

3.

Configuring log file parameters
You can set log keeping parameters both on the Axxon PSIM setting panel in the Tweaki.exe utility (see The Settings 
panel of the Axxon PSIM section) and using some registry keys:

The Time of log keeping (hours) parameter means the same as DebugTime registry key. It specifies the 
number of hours for keeping log files. 48 hours by default.
The Maximum size (MB) parameter means the same as DebugSize registry key. It specifies the number of 
megabytes provided for log. 100 MB by default.
The DebugZipDays registry key enables the logs archiving in the .gz format and specifies the time period for 
their keeping. 2 days by default.

Log files are rewritten when the maximum of one of the parameters is reached.

When the Debug 4 debug mode is enabled, the video.run log file displays the most detailed information about the 
file system and memory usage of each camera every 10 seconds. To reduce the number of info lines,, displayed 
every 10 seconds, to 6 (this will reduce the size of the log file), it is necessary to add the StatusInfo=0 key.

An example of the displayed information if StatusInfo=1 or no key:

Uptime: 00:00:12, memory: 423.0 MB
[FS]Health ok.
[FS]Ring cycles count: 0
[FS]Total index in memory size: 62.7 KB
[FS]Total recorders: 4, MemFile: -1, memFile total size: 16.0 MB, last frame skipped 
time: none, WritingQueueSize: 1500, avg speed: 18.99 MB/sec.
[FS]Total readers: 0 (cached frames: 0)
[FS]Total cameras: 4, internal VMDA detectors: 0, external VMDA detectors: 0. zone 
detectors: 0.
[FS]Camera 1. Writing queue: 1 frames(0% of 1500), size: 0.00 MB(0 ms). Streams(1): 1,
 total VMDA detectors 0 (int: 0, ext: 0), zone: 0. Grabber_IP_CAM queue size: 0.
[FS]Camera 2. Writing queue: 0 frames(0% of 1500), size: 0.00 MB(0 ms). Streams(1): 2,
 total VMDA detectors 0 (int: 0, ext: 0), zone: 0. Grabber_IP_CAM queue size: 0.
[FS]Camera 3. Writing queue: 0 frames(0% of 1500), size: 0.00 MB(0 ms). Streams(1): 3,
 total VMDA detectors 0 (int: 0, ext: 0), zone: 0. Grabber_IP_CAM queue size: 0.
[FS]Camera 4. Writing queue: 0 frames(0% of 1500), size: 0.00 MB(0 ms). Streams(1): 4,
 total VMDA detectors 0 (int: 0, ext: 0), zone: 0. Grabber_IP_CAM queue size: 0.
Total registered senders: 1
Objects:
VideoFrame: 38(max: 77 at '09-09-22 14:40:13.014')
AudioFrame: 0(max: 5 at '09-09-22 14:40:08.816')
Msg: 73(max: 130 at '09-09-22 14:40:06.733')
Active[1]
SendVideoFrame(local=1,compressed=1) to 'TAG-5509.1': value: 0 (max 0), delay = 46
 ms, 09-09-22 14:40:15.548
Inactive[0](no new data for more than 15 seconds)

An example of the displayed information if StatusInfo=0:

Note

Find details in the The Debug window section of Programming Guide (JScript).


https://docs.axxonsoft.com/confluence/display/PSIM100en/The+Debug+window
https://docs.axxonsoft.com/confluence/pages/viewpage.action?pageId=235441966
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Uptime: 00:00:12, memory: 427.0 MB
[FS]Health ok.
[FS]Ring cycles count: 0
[FS]Total index in memory size: 52.9 KB
[FS]Total recorders: 4, MemFile: -1, memFile total size: 16.0 MB, last frame skipped 
time: none, WritingQueueSize: 1500, avg speed: 7.42 MB/sec.
[FS]Total readers: 0 (cached frames: 0).

Find more about registry keys in Registry keys reference guide.

Example.

The Time of log keeping (hours) is 720 hours (1 month) and the Maximum size (MB) is 100 MB.  

One week later the size of log file is 100 MB. It starts being rewritten though the log is kept less than it was specified. 

And if DebugZipDays has the value equal to the time period in days to keep logs, then logs are not rewritten − they 
are archived in the *.gz format and are kept for so long as it was specified in DebugZipDays parameter.

21.4.2 Extended setup of the distributed architecture
Extended setup of the distributed architecture is performed in the DNS section; it is intended to create reserve 
connections between the Client and other cores (Servers) in case of loosing connection with the main core. Reserve 
connections are to be set up for each Client individually.

To create a reserve connection between the Client and a core, do the following:

Stop the Axxon PSIM software if it was running.
Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility).
Select the DNS node in the tree on the left side of the utility dialog box (see The Settings panel of the DNS 
section).
Specify the core computer name and IP-address in the table.
Click OK. 

21.4.3 Changing computer names and IP addresses in the Axxon PSIM 
configuration database

The Distributed configuration node allows changing the computer name and/or IP address in the Axxon PSIM
database.

To change the computer name in the configuration database, do the following:

Shut down Axxon PSIM if it runs.
Start the tweaki.exe utility (see Starting and shutting-down the Tweaki.exe utility).
Select the Distributed configuration in the tree on the left side of the utility dialog box (see The Settings 
panel of the Distributed configuration section).
Select the database containing the computer name to be changed using the Select database (1) or Use 
current DB (2) buttons.

https://docs.axxonsoft.com/confluence/display/PSIM100en/Registry+keys+reference+guide
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4.

As a result the Available systems (3) table will show all computer names registered in the selected 
database.
To select the computer name to be changed in the Available systems table, right-click an appropriate row. 
The row will be highlighted.
Click the button next to the New system ID (4) field to see the drop-down list of available computer names. 
Select the required computer name in the list. The selected name will appear in the New system ID field. 
Name can also be entered in the field manually.
Set one of the following checkboxes: Update Protocol (5) checkbox to replace the computer name in the 
events log, or the Clear protocol checkbox to delete all records in the log. Only one of two checkboxes 
should be set.
Click the Update DB button (7). The progress of replacing computer names for a new one will be displayed in 
the field below the Update DB button (8).

To change the IP address in the configuration database, do the following:

Do steps 1-4 of the previous instructions.
Select the IP address to be replaced from the drop-down list (9).
Enter a new IP address into the field (10).
Click the Edit button (11).

The IP address in the database will be changed.
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21.4.4 Limiting memory usage by an MS SQL server
A certain amount of disk space is allocated for the SQL server for storing its data, functions and other internal 
structures. Allocated RAM is determined by default by the total RAM resources available for the SQL server in the 
system. The Tweaki.exe utility allows limiting the amount of RAM allocated for the SQL server. Do the following:

Close the Axxon PSIM software if it is open.
Start the Tweaki.exe utility (see Starting and shutting-down the Tweaki.exe utility section).

Select the Configure MSDE (MS SQL) node in the tree on the left side of the utility dialog box (see The 
Settings panel of the MSDE (MS SQL) configuration section).
Select the MS SQL database to limit the allocated RAM by doing one of the following using Select 
database (1) or Use current DB (2) buttons.
In the Maximum memory usage (MB) (3) enter the required amount of memory to be allocated for the SQL 
server.
Click the OK button (4).

21.4.5 Re-indexing the audio and video recordings archive
To re-index the audio and video archives, do the following:

Close the Axxon PSIM software if it is open.
Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility).
Select the Video Subsystem node in the tree on the left side of the utility dialog box (see The Settings panel 
of the Video subsystem section).
Click the Rebuild Index button to delete the INDEX folder with .idx files containing the indexes to the video 
recording files in the archive.

Note.
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Click OK.
Start the Axxon PSIM system again. A new INDEX folder will be created in the video archive folder, containing 
new indexes.

This completes re-indexing of the database.

21.4.6 Enabling the Pure video/CUDA hardware acceleration
It is possible to enable the PureVideo/CUDA hardware acceleration when video signals are decompressed from IP 
devices. In this case decompression may be carried out by Server’s graphics processor and this reduces the load on 
CPU.

The PureVideo/CUDA hardware acceleration functionality is implemented correctly when Server meets the 
following requirements of the software platform:

Is managed by OS Windows XP/Vista/7.
The PureVideo HD video card of the second or third generation is installed (NVIDIA VP2 and VP3).

Pressing the button  Rebuild index sets the value of parameter IndexRebuilding=1 in the register’s 
branch of OS Windows: HKLM\SOFTWARE\AxxonSoft\PSIM\VIDEO for 32-bit system 
(HKLM\SOFTWARE\Wow6432Node\AxxonSoft\PSIM\VIDEO for 64-bit). Alterarchive reindexing the 
value of the parameter IndexRebuilding=0 is automatically set. When Axxon PSIM software is run 
together with IndexRebuilding=1 parameter, the archive is reindexed without any attempt to reas it 
from *.idx files.

Attention!

 It is recommended to update the driver of the card that supports the PureVideo/CUDA hardware 
acceleration. Drivers are available for downloading at the official web page of NVIDIA (www.NVIDIA.com).



Note.

Detailed information about the PureVideo/CUDA hardware acceleration is given in reference manual of 
NVIDIA company.



1.
2.
3.
4.
5.
6.

Note.

Widespread models of video cards that support the PureVideo/CUDA:
NVIDIA GeForce GTX 295;
NVIDIA GeForce GTX 285;
NVIDIA Quadro NVS 450;
NVIDIA GeForce 9800 GT;
NVIDIA Quadro NVS 420;
NVIDIA Quadro NVS 295.



Note.

 In the Axxon PSIM software package the PureVideo/CUDA hardware acceleration is applied only for video 
signals’ decompression in H264 codec.



Note.

http://www.nvidia.com
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To enable the PureVideo/CUDA hardware acceleration, do the following:

Shutdown the Axxon PSIM software package if it was run on the computer.
Run the Tweaki.exe utility (See the Starting and shutting-down the Tweaki.exe utility section).
Select the Video subsystem section in the tree in the upper left corner of the utility’s dialog box (see The 
Settings panel of the Video subsystem section).
Set the Use PureVideo/CUDA hardware acceleration checkbox.
Click the OK button.
Go to the settings panel for the Camera object.
In the Decompressor drop-down list select the H264CudaVP2Decoder value.
Click the Apply button.

The PureVideo/CUDA hardware acceleration is now enabled.

21.4.7 Testing video capture cards
To test a video capture card, test its channels using the Testing video capture cards module of the Tweaki.exe 
utility. Do the following:

Shut down the Axxon PSIM software if it is started.
Start the Tweaki.exe utility (see the Starting and shutting-down the Tweaki.exe utility section).
Select the Testing video capture cards node in the tree on the left side of the utility dialog box (see The 
Settings panel of the Testing video capture cards section).
Press Test button.

The Board field will display the name of the video capture card, and the Channels state table will show the 
information about each channel of the card (number and status). The confirmation of successful testing will be 
displayed to the right of the Channels state table.

 If the resolution more than 1920x1088 is set in the camera, then the PureVideo/CUDA hardware 
acceleration is not used for video signals’ decompression.
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22 The utility for collecting configuration data on servers and 
RWS for the Technical Support

22.1 The purpose of the Support.exe utility
The Support.exe utility is designed for collecting information about the configuration and operating status of the 
hardware, OS Windows and the Axxon PSIM™ system. The utility generates an archive that can be used by AxxonSoft 
Technical Support Service for troubleshooting purposes. In case of system malfunction or errors in the Axxon PSIM™ 
system, do the following:

Go to the AxxonSoft tech support server:  https://support.axxonsoft.com/.
Register a new account on the tech support server or log in the registered account.
Create an issue for tech support. Attach an archive generated by Support.exe utility.  

Information on the issue progress will be sent to the email specified at registration.

22.2 Starting and shutting-down the Support.exe utility
To run Support.exe utility, use one of the following methods:

From the Start menu of OS Windows: Start -> All programs -> Axxon PSIM -> System’s information 
gathering utility
From the Tools folder of the Axxon PSIM program folder: <Axxon PSIM>\Tools\Support.exe

After running the Support.exe, the Support – Collecting info about system utility dialog box is displayed.

How to get technical support

https://support.axxonsoft.com/
https://docs.axxonsoft.com/confluence/display/SUPPORT/How+to+get+technical+support
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To close the Support.exe utility, click the Close button.

22.3 The Support interface description
Support.exe utility interface includes the following elements:

Short directions for using the Support.exe (1).
A group of settings for specifying data set collection time period (2).
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Collect button to run the process of gathering information (3).
Filed of displaying the information (4).
Table to display and select steps of gathering information, it includes two columns – Step and Status. In the 
Step column, the short characteristics of information gathering process step is displayed and the step can 
be cancelled before the information gathering starts. In the Status column there is displayed process-bar 
and time, spent on information gathering (5).

To close the Support.exe utility, click the Close button.
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22.4 Collecting information about videoservers and remote workstations 
using the Support.exe utility

To collect the information using the Support.exe utility, do the following:

Start the utility.
If necessary set the dump and log files collection parameters:

In the Collect dump files for ___ days field specify the number of days for which dump files are to be 
included into the data set for technical support (1).
In the Collect log files for ___ days field specify the number of days for which log files are to be 
collected into the data set for technical support (2).

By default, all available system information is collected. If necessary, uncheck the boxes next to the 
information collection steps that should be skipped (3). If unchecked, information is not collected at the 
corresponding step.
Some stages of information collection are mutually exclusive, for example, you cannot simultaneously select 
the Creating an archive copy of the MS SQL Sever database and Creating the archive copy of the DB 
without the protocols checkboxes.
Some steps cannot be excluded, including Compressing files and Removing temporary files.
Click the Collect button (4).

The data collection process will start. Upon completion, the result of information gathering on each step is 
displayed in the Status column (5), while the information area will show the link to the newly generated file – 
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support.7z (6).

Follow the Open Folder with Support.7z File link to view the archive (6).
The archive is saved in C:\Users\%current user name%\Documents\Support\.
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23 The Fps.exe utility for productivity estimation

23.1 The purpose of the Fps.exe utility
Productivity measurement fps.exe utility is used to estimate productivity of video processing.

Estimation is done in the following way:

Segmentation of the given video fragment for a set of frames in jpeg format.

Compression and/or decompression  of the created frame set.
Calculation of productivity parameters − number of processed fps with defined resolution and colour.

23.2 Starting and shutting-down the Fps.exe utility
To start fps.exe, do one of the following procedures:

Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Tools, then 
FPS testing utility.
The fps.exe utility is available from the Start menu with the following installation types of the Axxon PSIM
software: Server, Remote administrator workstation, Remote client.
Start the utility from the Tools folder of the Axxon PSIM program folder: <Axxon PSIM>\Modules64\fps.exe.

After starting the fps.exe utility there will be a dialog window Video processing FPS tester.

Note.

If the video fragment is not set, the utility generates pattern set of frames. When necessary the 
utility may store the created set for fames to the selected directory.



Note.

 Compression is not available on the Cilent. Playback of a previously recorded video, or a video being 
received over the network in real time, is available.


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To close fps.exe utility click   in the right upper corner of the utility’s dialog window.

23.3 Using the Fps.exe utility

On the page:

Selecting the video 
source
Setting the check 
parameters
Running the check and 
reading into its results

To check productivity of video processing, do the following:

Start the fps.exe utility (see Starting and shutting-down the Fps.exe utility).
Select the video source.
Set the check parameters.
Run the check and read into its results.
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23.3.1 Selecting the video source
The video source can be either an archive file or a video server archive recorded on specific cameras.

If the video source is an archive file, select it as follows:

Click File and then double click the required file in the Windows standard Open box (1).

The full name of the selected file is displayed in the Video source field (2).

If the video source is a video server archive, make sure the Axxon PSIM is running on that server and all the required 
cameras are created in the hardware tree before performing the check.

Select the archive video source as follows:

Click Server (1). The Cameras dialog box opens.

In the IP field, specify the IP address of the Axxon PSIM video server (2).
Click Get (3). If connection with the server is established, the Cameras field displays the list of cameras.

Note.

The field Video Source File is not required to run the check on an emulated pattern set of frames.

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Set the check boxes next to the cameras to check performance using their archive (4) or set the Select all
check box to select all the cameras in the list (5).
Click OK (6).
The selected cameras are added into the Video source field (7).

23.3.2 Setting the check parameters
Set the parameters of performance check as follows:

Activate Compression check checkbox to check how many fps  the given computer can compress (1).

Activate Decompression check checkbox to check how many fps  the given computer can decompress(2).
Select the Copy for stream check box to create a separate copy of each stream file in the RAM in order to 
avoid conflicts during the check (3). This function increases memory consumption when running the fps.exe 
utility.
Select the required compressor version from the drop-down list Codec (4).
Enter the required number of emulated cameras in the field Channels amount (5).

In the Number of CPU cores in use field specify the number of CPU cores to be used for performance check 
(6).
Select the required value of frames compression from the dropdown list Quality (inversely to compression 
level) (7).
When necessary, set the directory where frames extracted from the video would be unzipped by clicking 

 next to the Jpeg images storage folder field (8).

23.3.3 Running the check and reading into its results
Click the Start button to run video processing tester (1).

Note.

This setting is actual only with emulation of pattern set of channels.

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As a result, parameters of video processing productivity will be displayed in the title bar of the utility window (2).

Productivity parameter Description of parameter

Compression total number of frames that can be compressed in one 
second

Decompression total number of frames that can be decompressed in one 
second

Ratio compression ratio

Version selected version of the compressor

Width frame width

Height frame height
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Productivity parameter Description of parameter

Color if the frame is in color

CPU number of CPU cores in use

Compressors $ decompressors per thread number of compressor instances per CPU

If the Jpeg images storage folder is selected, the frames for testing video processing will be recorded to the 
selected .jpeg files storage folder.

The example of the emulated frame is shown below:

To stop the testing process, click the Stop button (3).
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24 The ddi.exe utility for editing database templates and external 
settings files

The ddi.exe utility is designed for editing external system settings files (*.ddi) and the templates of the main 
database (psim.dbi and psim.ext.dbi).

The ddi.exe utility is started from the Start -> All Programs -> Axxon PSIM -> Tools -> System configuration 
menu.

The ddi.exe utility is available from the Start menu with the following installation types of Axxon PSIM: Server, 
Remote administrator workstation, Remote client.

The utility can also be started from the Tools folder of the Axxon PSIM program folder.

After the changes are made to *.ddi and/or *.dbi files, update the main database. For this use the idb.exe utility (see 
The idb.exe utility for converting databases, selecting database templates and making backup copies of databases
section).

24.1 Editing psim.dbi and psim.ext.dbi database templates using the 
ddi.exe utility

To edit the template of the main database, open it using the File -> Open menu. The template files are stored in the 
root of the Axxon PSIM program folder.

Psim.dbi file contains the list of main tables and fields of the database. User-defined tables and fields are stored in a 
separate file – psim.ext.dbi. This file is made separate from the main file, to eliminate the need to re-insert user-
defined tables and fields into the main file, in case of Axxon PSIM system update. The contents of these files are 
merged upon Axxon PSIM start-up.

To view the database template, open the DBI tab in the top left corner of the window. The list of the tables of the 
main Axxon PSIM database will be displayed in the left panel. The right panel will show the list of fields of the 
selected database.

Note.

 If changes were made to .ddi or .dbi files using the ddi.exe utility and these files were installed along with 
Axxon PSIM, then these files will be deleted while deleting with configuration upload. .ddi and .dbi files 
added manually will be saved.



Note.

To open the recently used file, select the Last files item in the File menu or open the context menu in the 
Names tab.



Note.

The Paste from file item in the File menu allows opening several files by adding tables, described in other 
dbi files, to the open dbi file.


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To delete, add, edit or copy object fields, use the table on the left of the utility box.

The following parameters of the table fields are displayed:

Field name – the name of the field in the database.
Type – data type of the field contents. Available types:

BIT – checkboxes taking logical values Yes and No;
CHAR – fields with a few symbols;
DATETIME – date and time in the following format: date – dd-mm-yyyy, time – hh:mm:ss;
DOUBLE, INTEGER, SMALLINT – numerical fields of corresponding types;
TEXT – fields with the text.

Size – maximum number of units of the specified format in a field.
Description – field name shown in the interface.

The database is to be refreshed after the changes were made.

24.2 Editing the external setting file (Axxon PSIM.ddi) using the ddi.exe 
utility

To edit the external settings file (psim.ddi), open it using the File -> Open menu. This file is stored in the root of the 
Axxon PSIM program folder.

Note.

To open the recently used file, select the Last files item in the File menu or open the context menu in the 
Names tab.


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The external settings file contains the information about objects and events loaded into the system configuration, 
graphical symbols for various object states on the map, and the transition rules from one object state to another.

The purpose of editing can be software localization or expanding/limiting its functionality (for example, removing 
unused objects from the system).

The database is to be refreshed after the changes were made.

24.2.1 General information on editing the external setting file
To start using the utility, open the DDI tab in the top left corner of the utility dialog box.

The left side of the dialog box will display all system objects loaded into the configuration. The right side of the 
dialog box shows the properties panel for the selected object. This panel consists of several tabs: Names, Events, 
Reactions, Icons, States, and Transition rules.

To delete, add, edit or copy object properties, right-click a cell in the tab or the list of system objects to open the 
context menu. You can also use Ctrl+C and Ctrl+V to copy and paste lines from one object to another. Select the 
whole line(s) or just a cell(s) in it to copy by Ctrl+C. Delete lines with Delete key.

To edit the object properties, use the tables on the right of the ddi.exe utility box.

24.2.2 The Names tab
This tab contains the table with three fields:

Object – object ID in the system.
Name – the name of the object in the system.
Group name – the name of the group the object will be assigned to upon creation. If this field is left blank, 
no group will be created. Objects of different types may be assigned to the same group given that they have 
the same parent object (e.g., Sensor and Relay can be included to the "Sensors and Relays" group and so 
on).

By default all objects, the description of which the ddi file contain, are displayed in the table. To find an object, 
type-in the object name or ID in the Search by name field. As a result the table will contain all object names in the 
system that exactly or partially match the word typed in this field.

Note.

The Paste from file item in the File menu allows opening several files by adding tables, described in other 
dbi files, to the open dbi file.



Note.

 Changing the external settings file may lead to system failure. Create a backup copy of the file before 
editing it.


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24.2.3 The Events tab
This tab contains the list of the system events that the selected object can create. Each event has the following 
editable parameters:

Name. The event identifier.
Description. A short description of the event.
Processing messages. The type of window to open on event occurrence: alarm window or information 
window.
Support audio. The attached .wav files to be played when the event occurs.
Disable network connection. A local event only. If this checkbox is set, other computers on the network will 
not be notified when the event occurs.
Disable logging. By default, all events are displayed in the Event log. Set the checkbox not to log the event 
or record it in the database.
Windows log. Set the checkbox to log the event (see step 6) to Windows log. If the event is not logged, then 
it cannot be logged to Windows log.
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24.2.4 The Reactions tab
This tab lists all reactions that the object can make in response to events. Each reaction has the following 
properties:

Reaction – reaction ID.
Description – short description of the reaction.
Arming  – additional property of the reaction, arming a region.

Note

You can create only the events that are available for the selected object (created at the stage of the system 
programming). Initially all of them are in the psim.ddi file.


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24.2.5 The Icons tab
This tab lists the graphical symbols (icons) that represent the selected object on the map. The part of the name 
used for identifying the file in the .bmp, .jpg or .png format is specified in the File name column. Image files are to 
be stored in the Bmp folder in the Axxon PSIM program folder (for example, C:\ Program Files\Axxon PSIM\Bmp).

Note.

You can create only the reactions that are available for the selected object (created at the stage of system 
programming). Initially all of them are in the psim.ddi file.


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If default icons are to be in use for the same states of objects of the same type, the def icon should be specified on 
this tab (By default). See The States tab section for more information.

24.2.6 The States tab
This tab lists all states of the selected object. The states have the following properties:

Name – state ID.  
Image – part of the name in the .bmp format that represent the object state on the map. For example, if the 
zone_fire file name was selected in the Icons tab, and the image of the selected ARMED state is arm, then the 
zone_fire_arm.bmp  file will be in the Bmp folder.

The default icon for the states can be set. For this, set the def icon (By default) on the Icons tab. For example, if 
there is no zone_fire_arm.bmp icon for the ARMED state, then the def_arm.bmp icon will be searched. This avoids 
duplicating icons if one state for the different types of the object icon should be displayed identically.

Note.

 If the file ID is not set in the Icons tab, then the file name will consist of the object ID and part of the file 
name specified in the Image column.


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Description – short description of the state.
Flicker when alarm – option of displaying object state – flickering.

 

24.2.7 The Transition rules tab
Transition rules connect the events generated by objects, and the states of these objects. Each rule consists of the 
starting state of the object, an event, and an ending state that the object will take after the event.

The table lists the transition rules from one object state to another. Each rule has the following properties:

Event – identifier of the event triggering the transition.
Transition from state – identifier of the object state before the event took place. If this field is left blank, the 
rule will apply to all starting states.
Transition to state – identifier of the resultant state of the object.

Note.

If the object is displayed on the map as a polygon, circle or line, then the color of these figures can be set 
for each state.  
For this specify the color in the R:G:B:A format after the icon name (separated by &) in the Image column 
or specify the color only in this format instead of the icon name. Here are the examples of the Image 
column contents:
255:0:0 – red color is set for the state.
alarm&255:0:0 – icon and red color are set for the state.


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24.2.8 Example of editing the Axxon PSIM.ddi file to reduce database load
When changing the ddi file events, reactions, etc. can be added, modified or deleted. 
To reduce database load modify the psim.ddi file as follows: 

Open the psim.ddi file in the ddi.exe utility.
Select the CAM object.

Go to the Events tab.
Set the Disable network connection and Disable logging checkboxes checked for the MD_START (Alarm) 
and MD_STOP (Alarm end) events.
Save the file.
Update the database using the idb.exe utility (the Update database button, see Interface elements of the 
idb.exe window).

When these actions are performed the events from the main motion detection tool are not recorded and sent to 
other cores. This reduces the database load.

https://docs.axxonsoft.com/confluence/display/Int410en/Interface+elements+of+the+idb.exe+window


PSIM 1.0.0-1.0.1 (english) – Additional Utilities for the Axxon PSIM Software

The ddi.exe utility for editing database templates and external settings files– 112

In order the psim.ddi file is not substituted it is to be saved with another name at step 5 - e.g. "psim_1.ddi". Thus, 2 
files of external settings are saved in the Languages catalog: source file and modified one. The idb.exe utility loads 
them in alphabetical order. As a result the psim_1.ddi file is loaded the last one and its parameters are applied 
when database is updated.

If the event list in psim_1.ddi is different from the original psim.ddi, e.g. some events are added or deleted, then the 
event list is merged by idb.exe DB update.

When installing a new Axxon PSIM version the psim_1.ddi file is not affected by the installation wizard and changes 
are saved.

Important!

When updating Axxon PSIM the modified psim.ddi file is substituted with the file by default.


Important!

When deleting Axxon PSIM without saving the configuration the entire Axxon PSIM catalog (including 
modified files) is deleted. In this case the modified files are to be manually backed up, e.g. to C:\Temp, 
under after reinstallation they are to be copied to <Axxon PSIM installation folder>\Languages\en.


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25 The Arpedit.exe utility for creating user dialog windows
The Arpedit.exe utility is designed for creating dialog boxes. It allows tailoring Axxon PSIM system to particular 
monitoring and security tasks of the customer.

The Arpedit.exe utility is in the “Arpedit” folder (<Installation directory>\Axxon PSIM\Tools\Arpedit). Detailed 
information on the utility is given in User's Manual for ArpEdit (it is located in pdf format in the same folder too).

25.1 User's Manual for ArpEdit

25.1.1 Introduction into User's Manual for ArpEdit

On the page:

The purpose of 
the document
The purpose of 
ArpEdit

 

The purpose of the document
The User’s Manual for ArpEdit is a reference tool and contains information needed to work with the ArpEdit. This 
utility is included in the basic distribution of the Axxon PSIM software package.

The following materials are included in this manual:

General information on ArpEdit.
User guidelines for ArpEdit.

The purpose of ArpEdit
ArpEdit is designed to perform the following functions:

Creating badge forms for the Access Control Service module (in the form of files with the .arp extension).
Creating user dialog boxes (in the form of files with the .dlg extension).

Note.

The dialog box is connected to Axxon PSIM via a system operator object query window and displayed as a 
result of the macro commands that are specifically designed to work with this dialog box. Thus, the ArpEdit
utility allows you to completely adapt Axxon PSIM to solve particular problems of control and security at a 
production facility.


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25.1.2 General principles of operating ArpEdit

Starting and shutting down ArpEdit
Launching ArpEdit can be done in one of the following ways:

Launch from the Axxon PSIM installation directory. To launch the ArpEdit utility from the Axxon PSIM 
installation directory, follow these steps:

Go to the folder where you installed Axxon PSIM (default directory is C:\Program files\Axxon PSIM).
Go to the Tools\Arpedit folder.
Launch the file arpedit.exe.

Launch from the Start menu. To launch the ArpEdit utility from the Start menu, select the menu item Create 
dialog windows, located in Start → Axxon PSIM.

Closing the operation of the ArpEdit utility may be done in one of the following ways:
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In the system menu of the ArpEdit utility, in the File heading, select Exit.

Click .

If the document contains any unsaved changes, a Report editor dialog box appears.

To confirm the changes, click Yes. To exit the program without saving the changes, click No.

The utility window will close.

Description of the interface elements of the ArpEdit utility
The ArpEdit utility window contains the following key interface elements:

Note.

More information on the interface elements of the ArpEdit utility can be found in the appendix (see 
APPENDIX 1. Interface elements of the ArpEdit utility).


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The System menu. Provides access to file operations, editing functions and window display settings for the 
ArpEdit utility (1).

Toolbar. Provides access to key features of the utility (2).
Workspace. Contains elements of the badge or dialog box, add users, and allows for the management of 
placement and sizes (3).
The status bar displays information about the actions produced by the utility (4).

Creating ArpEdit objects
ArpEdit objects are divided into the user interface and variable elements. To create a new object in the workspace, 
follow these steps:

Select a section of the workspace where you want to add an item, click on it. The selected part will be 
highlighted in blue.

Go to the ArpEdit toolbar.
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Select the object to be added by clicking the left mouse button on the appropriate icon on the toolbar (see 
description below).
Click the left mouse button at the point in the workspace in which to place the upper left corner of the 
object.

ArpEdit objects:

Name Description Purpose

Text Fixed text field Display fixed text field

Name Description Purpose

Variable Variable text field, hidden text box, button 
or drop-down list

Displays information from the 
database when creating badges
Variable when creating dialog boxes

Name Description Purpose

Line A line of given length and direction Design element

Name Description Purpose

Frame Set rectangular frame sizes Design element

1.
2.

1.
2.

Note.

The dimensions of the created object can be changed in two ways:
By dragging the right or bottom edge of the object with the mouse.
By setting new values for the height and width of the object in the field box (see Setting field 
variables).

The position of the created object can also be modified in two ways:
Dragging the object with the mouse from the top or left edge.
By setting the new position of the object in the field variable window (see Setting field variables).


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Name Description Purpose

Square Set filled square sizes Design element

Name Description Purpose

Image Image placed at a specific location Insert client photographs in the badge form for 
printing

Creating a new object is finished.

Setting object display variables

Setting field variables

To set the field variables, follow these steps:

In order to set the field variables, it is necessary to select the variables of the object in the workspace, and 
open the Variables field in one the following ways:

Click  on the toolbar;
In the object functional menu, select Properties.

Note.

The object functional menu is opened by right-clicking anywhere inside the object.

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The Field variables window will appear.

In the text field (1) enter information describing the field:
Enter text in Text field, which will be displayed in the text field.
For Variable, enter the variable name.
For an Image, enter the image address in quotes. The image must be placed in one of the following 
folders:

In the Axxon PSIM software installation folder (e.g. C:\Program Files\Axxon PSIM), then in the 
field (1) enter the image name, e.g. “image.bmp”.
In the Bmp folder of the Axxon PSIM software installation folder (e.g. C:\Program Files\Axxon 
PSIM\Bmp), then enter the image file address as "Bmp\image.bmp" or "Bmp/image.bmp".

If you would like to fill in the text field with data from a text file or enter a large amount of data, then click the 

 button (2) and use a text editor (see the section in APPENDIX 2. Entering text using the editor).
Set the Alignment settings for the desired justification of the text within a selected object (3).
Select units of measure which will be used to size the object:

If the size of the object will be given in millimeters, then check the in mm box (5).
If the size of the object will be given in characters [symbols], then check the Width in symbols box 
(9).

Set the position of the upper left of the object in one of the following ways:
Specify the absolute coordinates of the object. In this case you should indicate the position of the 
upper left corner by setting the X-axis in the X field, and the Y-axis in the Y field: (6)
Specify the relative coordinates of the object. In this case you should check the Relative box (4).

The width and height of the object can be set in one of the following ways:
Specify the width of the object in the W field, and the height of object in the H field (7).
Specify the coordinates of the lower-right corner. To do this, check the X2, Y2 box (8). The W and H 
fields will be by X2 and Y2. After this, specify the coordinates of the lower-right corner of the object 

Note.

The size of the object is given in characters [symbols] by default.

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9.
10.

11.
12.

1.

using the X2 field for the x-axis and the Y2 field for the y-axis.

Specify the line thickness in the Line thickness field in the desired units (10).
If a custom object should be on the badge or there is a dialog window, but it should not be visible to the 
user, then check the Hidden box (11).
If the object must be part of a group, check the Group box (12).
Click OK (13).

Setting the variables is completed.

Setting the text font

To set the text font, follow these steps:

Select Font from the menu.
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2.

1.

Using the standard font selection menu, set the text display settings.

Setting the text font is completed.

Setting the color

To set the color, follow these steps:

Select Color from the menu.
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2.

1.

Using the standard color selection menu, select the color desired for the object.

Setting the color of the object is completed.

Setting the background color of the object

To set the background color of the object, follow these steps:

Select Background color from the menu.
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2.

1.
2.
3.

1.

2.

Using the standard color selection menu, select the background color desired for the object.

Setting the background color of the object is completed.

25.1.3 Creating dialog boxes

Creating a dialog box form
In the Axxon PSIM dialog box, objects will be displayed in the ArpEdit workspace.

Create a dialog box form in the following order:

Create design elements in the workspace.
Create variables in the workspace.
Configure the design elements in the workspace.

Create design elements

The design element types in the dialog box correspond to their appearance on the workspace. You can add the 
following design elements to the dialog box form:

Square. Adding a square in the workspace is done by clicking on the   on the ArpEdit toolbar (1).

Line. Adding a line in the workspace is done using one of the following buttons:    on the 
ArpEdit toolbar (2).
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3.

4.

1.

2.

Text field. Adding a text field in the workspace is done by clicking on the  on the ArpEdit toolbar (3).

Frame. Adding a frame in the workspace is done by clicking on the  on the ArpEdit toolbar (4).

Creating design elements is completed.

Creating variables

Creating variables in the workspace is done using the  on the ArpEdit toolbar. Depending on the variable 
setting they may be displayed in the dialog box as follows:

Editable text field (1). Additional configuration after adding is not needed (5).

Button (2). In order to display a variable as a button in the dialog box, you must configure it after adding it to 
the workspace, as follows (6):
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a.

b.
c.

d.
3.

a.

Click  on the toolbar. The Field options window will open.

Place a colon in front of the variable name (1).
In the Calculation formula field, specify the variables for the DoReact function using quotes “,” – 
which will be used with the button is clicked (2).
Click OK.

Drop-down list (3). In order to display a variable as a drop-down menu in the dialog box, you must configure 
it after adding it to workspace, as follows (7):

Click  on the toolbar.
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b.

c.
d.

e.

1.
2.

3.

Double click on the frame around the variable name. The Field options window will open.

Check the Drop-down menu [Pulldown list] box (1).
If you would like to manually specify menu values, then you must enter the desired value in the Fill 
list field, using the character “|” as the separator between values (2). To enter a large amount of text 

or to paste text from a file, click  and use the editor (see the section in APPENDIX 2. Entering text 
using the editor).
Click OK.

Creating variables is completed.

Setting up workspace objects

After adding interface elements and variables to the workspace, it is necessary to configure them. Configuring 
interface elements includes specifying their display variables (see the section on Setting object display variables).

To configure a variable, follow these steps:

Click  on the toolbar.
Double click the left mouse button on Variable menu item that you wish to set. The Field options window 
will open.
Enter the name of the variable in the Text field (1).
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4.
5.
6.

7.

8.

9.

Enter the Default value in the field, of the variable that will be the default value (2).
Set the switches (3) to the position corresponding to the type of variable.
Specify the format for the variable. To do this you need to check one or more of the checkboxes in front of 
the format corresponding to the variable (4).
If you do not want to allow the value of the variable in the dialog box to be changed, then check the Non-
edit box (5).
If you want the value of the variable to be present in the dialog box, but not visible, then check the Hidden 
box (6).
Click OK (7).

Configuring variables is completed.

Note.

If there is a colon in front of the variable name (for example :var), the when creating a dialog box it 
will be displayed as a button with the same name (var). At the same time, in the Calculation 
formula field (3) the variables for the DoReact function will be displayed, delineated by the “|” 
character.


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1.

2.

Saving the dialog box form
To save the dialog box form, follow these steps:

 Select File, then click Save (1) or Save as… (2) to save the file under a new name.

Using the standard save file dialog, save the file with a .dlg extension [suffix].

Saving the dialog bog form is completed.

Accessing the dialog box from Axxon PSIM
To access the dialog box from Axxon PSIM, follow these steps:

Note.

The file extension should be entered manually in this case.


Important!

In order to have access to the saved dialog form file in Axxon PSIM, it should be saved in the following 
folder: <Path to installation directory of Axxon PSIM>/Program.


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1.

2.

3.

4.
5.
6.

7.
8.

Create an Operator query window under the Computer object in the Hardware tab of the Configure 
systems menu.

Go to the settings panel of the Operator query window.

Specify the window coordinates: in the X field specify the coordinates along the horizontal axis, in the Y field 
specify the coordinates along the vertical axis (1).
From the drop-down menu, in the Type column, select the type of object that trigger a dialog box (2).
From the drop-down menu, in the Number column, select the number of selected objected types (3).
Double click the left mouse button on the Name column (4). The cell will be automatically completed with 
the name of the selected object.
Specify the action to be performed upon the occurrence of a specified event, in the Event column (5).
Click Apply.

Important!

When you create an Operator query window in the number field you should specify the name of the 
saved dialog box form in the relevant director.


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1.

2.

3.
4.

Dialog boxes are used for programming the Axxon PSIM software package. More information on the built-in 
programming language can be found in the Axxon PSIM Software Package. Programming Guide.

Configuring the Operator query window is described in detail in the Administrator's Guide.

Example of creating a dialog bog to count the number of movements
This section provides an example of how to create a dialog box to count the number of movements. To create such 
a dialog box, follow these steps:

 Create a text field with the text Number of movements [Alarms:] (1).

Create variables (2).

Click  on the toolbar.
Double click on the frame around the variable name. The Variable field window will open.

Note.

In the example shown in the illustration above, the dialog box, created in the form, will be displayed from 
the macro.



https://docs.axxonsoft.com/confluence/display/PSIM100en/Administrator%27s+Guide
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5.

6.
7.
8.
9.

For the name of the variable, name it param (1). 

Check the Non-edit box (2).
Save the file with the name motion.dlg in the following folder: <Axxon PSIM installation directory>\Program
Run Axxon PSIM.
Create a directory try for the Operator query window in Axxon PSIM with the number motion.
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10.

11.

12.
13.

In Axxon PSIM create a Program under the Programs tab in the Programming dialog box of System 
settings (1).

Write the following code (2):

OnInit(){
param="0";
}
OnEvent("CAM","1","MD_START"){
DoReact("DIALOG","motion","CLOSE");
param=str(atof(param)+1);
DoReact("DIALOG","motion","RUN","param<" + param + ">");}

From the drop-down Time zone menu, select Always (3).
Click Apply (4).

This script indicates that if the video camera in sector 1 detects movement, then a motion operator query window 
will open, showing the number of movement alarms (param).

 

25.1.4 Working with badge forms
The ArpEdit utility supports work with the Visitor Management System (see Visitor Management System Module 
Settings and Operation Guide) module and allows you to create badge forms and output them for printing.

https://docs.axxonsoft.com/confluence/display/acfaen/Visitor+Management+System+Module+Settings+and+Operation+Guide
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1.

2.

a.

b.

Creating a badge form
Before you start to create badge forms, you need to make sure that you have created an Access Control Service 
object, as well as departments and users in Axxon PSIM.

To create badge forms in the Access Control Service, follow these steps:

Select the workspace section where the items will be added to the interface. Each section represents a single 
page.
Create the required number of variables, as follows:

Add a variable to the workspace by clicking  on the toolbar (1).

Click  on the toolbar.
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c.

d.

3.
4.

Double click the left mouse button on the border of the Variable that you wish to set. This will open 
the Field options window.

In the Field box [field], enter the name of the variable corresponding to the table in the Axxon PSIM 
database: dbo.OBJ_PERSON, from which data will be accessed for printing the badges (1).

Add the required design elements from the ArpEdit toolbar.
In order to allow the printing of photographs of employees on each pass for badge users, the Image should 
be set as follows:
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5.

6.

Select the required Image and click  on the toolbar. The Field options window will open.

In the Field options window, specify the following text string:  “<Axxon PSIM installation 
directory>\bmp\Person\”+id+”.bmp” (1). When outputting the badge to the printer, the id variable will be 
automatically read from the data base, and photography assigned to that ID by Axxon PSIM  will be printed 
on the badge.

Design elements used for badge forms:

Name Description Function

Text Uneditable text field Will display uneditable text information

Name Description Function

Line Line of any given length and direction Design element

Name Description Function

Frame Rectangular frame of a specified size Design element
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1.

Name Description Function

Square Filled rectangle of a specified size Design element

Name Description Function

Image An image placed at a specified location Insert user photographs on badge forms when 
printing

After adding all the required elements in the workspace, you must set the display variables (see section on Setting 
object display variables).

Creating badge forms is completed.

Saving badge forms
To save created badge forms, follow these steps:

From the File menu, select Save or Save as… to save a file with a new name.
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2. Using the standard save file menu, save the badge form file with a .arp extension.

Saving badge forms is complete.

Printing badges
To output badges for printing, select Printer network [Print’s Grid] from the File menu.

Outputting the badge to the printer is completed.

25.1.5 APPENDIX 1. Interface elements of the ArpEdit utility

System menu
The ArpEdit utility system menu provides access to the following functions:
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1.

2.
3.

File operations: creating, opening, saving, printing (1).

Text editing features (2).
AprEdit utility window display settings. In this menu, you can enable or disable the display of the toolbar and 
status bar (3).

Toolbar
The main way to manipulate objects in ArpEdit is via a toolbar, that has buttons to control the utility.

 

Description of the buttons in the ArpEdit utility toolbar:



PSIM 1.0.0-1.0.1 (english) – Additional Utilities for the Axxon PSIM Software

The Arpedit.exe utility for creating user dialog windows– 139

Workspace
The ArpEdit utility workspace is designed for the placement of objects in ArpEdit. When the Show sections  button is 
activated, the workspace will be divided into sections by horizontal lines.
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1.

Each section will have its own page. To start editing a section, select it by licking on the dividing line with the left 
mouse button. The selected section will be highlighted in blue.

25.1.6 APPENDIX 2. Entering text using the editor
You can enter text in the variable settings using the built-in ArpEdit editor. This editor should be used when you 
want to fill in a text field with data from a text file or a large amount of data.

To enter text using the editor, follow these steps:

Click  next to the text field.
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2.

3.
4.

5.

Open the Editor window.

Enter text in the text field (1).
If you want to paste the text into a text field from a text file, then click File… (2) using the standard open file 
dialog box, select the required text file. Text from the selected file will appear in the text field (1).
Click OK (3).

Entering text using the editor is completed.
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1.
2.

26 Configuration check tool
The Configuration check tool is designed for checking the settings of all created objects in the Axxon PSIM™ 
software and restoring the correct configuration if any changes occurred. Restoring is performed from the 
configuration template which can be created at any moment in accordance with current settings.

26.1 Starting and shutting down the Configuration check tool
To start the Configuration check tool, do the following:

Go to the Interfaces tab of the System settings dialog box.
Create the Configuration check object on the base of the Display object.
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3.

4.

5.

Go to the settings panel for the Configuration check object.

To configure the position of the Configuration check object, set the coordinates of upper left corner in X:, Y:
fields and values of window’s width and height in W:, H: fields, and select the computer monitor for which 
the coordinates are set.

To save the changes, click the .

As a result the Verifying configuration tool dialog box is displayed.
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To shut down the tool, click the  button on the main control panel of Axxon PSIM software and select the 
Close all menu item;
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1.

2.

3.

4.

26.2 Configuration check tool interface description
The dialog box of the Configuration check tool has four main interface elements:

The toolbar (1).
The tool’s control menu is located here.
The objects tree of Axxon PSIM software (2).
The objects tree of Axxon PSIM software is displayed here. Clicking the left mouse button on any object in the 
objects tree, the configuration of its parameters is displayed in parameters field (points 3-4).
The field of object parameters from Axxon PSIM configuration (3).
The current configuration is displayed in this field. These parameters are not available for editing.
The field of object parameters from a template (4).

Parameters of the selected object from the configuration template field are displayed here. These parameters are 
available for editing.

Note.

At the first start of the Configuration check tool, the current configuration of selected object is displayed in 
this field.


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26.3 Using the Configuration check tool
To start the operation, start the Configuration check tool (see the Starting and shutting down the Configuration 
check tool section).

26.3.1 Creating a template
To create a template in the Configuration check tool, do the following:
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1.

2.

In the objects tree, set the checkboxes next to those objects which parameters configuration will be included 
in a template.

Click the left mouse button upon the object which parameters configuration is to be edited.

As a result there is a list of object parameters with values, available for editing in the parameters from 
template field.

Note.

The set checkbox next to the required object is an obligatory term in order to edit the parameters.


Note.

 In the parameters from Axxon PSIM configuration field there is a list of object parameters with 
values set in Axxon PSIM software. They can not be edited.



Note.

At the first start of the Configuration check tool, the current configuration of selected object is 
displayed in this field.


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3.

4.
5.

6.

7.

Edit the object parameters. To edit the selected parameter, click the left mouse button upon the 
corresponding line with its value and edit it.
Repeat steps 3 for all objects, which parameters configurations are to be edited.
Go to the File menu of the control panel and select the Save template item.

Name a file and select the storage directory in the appeared window.

Click the Save button.

The template is now created.

26.3.2 Downloading and editing the template
To download and edit the template, do the following:
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1.

2.

3.

1.

Go to the File menu on the control panel and select the Load template item.

Select a template file in the appeared window and click the Open button.

The objects tree is displayed as a result. The active checkbox is next to the objects which configuration has 
been saved in the template.

To edit the template, repeat steps 1-7 of the Creating a template section.

The template is now downloaded and edited.

26.3.3 Verifying and correcting the configuration
To verify the current configuration of objects in Axxon PSIM software and restore it from the template, do the 
following:

Download the template for which the object configuration is to be verified in Axxon PSIM software (see the 
Downloading and editing the template section).
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2.

3.

4.

5.

a.

Go to the Configuration menu on the control panel and click the Test button.

As a result the objects which current configuration in Axxon PSIM software differs from that one in the 
template will be marked red in the objects tree. 

To view object parameters in the template which values are different from those ones in the Axxon PSIM
software, click the left mouse button upon the object marked red in the objects tree and go to the 
parameters from the template field.
Click the Distinguish button in the Template field.

As a result the parameters which values are different from those ones in Axxon PSIM software are moved to 
the Differences list.

Correction (if necessary) of these parameter in Axxon PSIM software for those ones from the template may be 
performed in two ways:

Click the Remove differences button in the Template field.
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b. Go to the Configuration menu on the control panel and select the Correct item.

The parameter configuration from Axxon PSIM templates is now verified and corrected.  
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27 Index.exe utility for reindexing archive files

27.1 The purpose of Index.exe utility
Index.exe utility reindexes archive files with big data array without restarting the Axxon PSIM software.

27.2 Starting and shutting down the utility
To start reindexing utility run index.exe executive file in the Modules64 folder that is in the catalogue of the Axxon 
PSIM software installation, for example, «C: \Program Files\Axxon PSIM\Modules64».

As a result the window of index.exe utility is displayed:

 

To stop working with index.exe utility click Close.

27.3 Using the Index.exe utility

Note.

Another way to perform reindexing of archive files is to shut down the Axxon PSIM software and delete the 
INDEX folder in the VIDEO folder on the disk with archive. Indexes will be rebuild automatically after the 
Axxon PSIM startup. This method is equal to using of the index.exe utility.



Attention!

Before you start working with the utility check the value of IndexRebuilding parameter in 
HKLM\SOFTWARE\AxxonSoft\PSIM\Video for 32-bit systems 
(HKLM\SOFTWARE\Wow6432Node\AxxonSoft\PSIM\Video for 64-bit) section of OS Windows registry: by 


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1.
2.

3.

4.
5.

To reindex archive files after its changing (for example, after copying new video recordings to one or several archive 
disks), do the following:

Start index.exe utility (see Starting and shutting down the utility section).
In appeared window select archive disks for reindexing by setting checkbox next to required disks (1). Check
Select All to set all checkboxes (2).
To start reindexing click the Start button (3).

Rebuilding process is displayed by progress bar (4) and in the text field (5).
When you finish reindexing, shut the window of utility.

Reindexing of archive files is completed.

To reindex archive files without using the dialog box, in the command line start index.exe utility with parameters, 
for instance, index.exe C, D command will reindex archive files on disks C and D. To reindex archive files on all disks, 
use the all parameter.

default it should be 0. If the parameter value differs from the value by default, you should change it to 0, 
otherwise the utility will not idex the archive.

Note.

At the time of reindexing all the elements of utility window are not active.




PSIM 1.0.0-1.0.1 (english) – Additional Utilities for the Axxon PSIM Software

The shedule.exe utility for creating a replication query file– 154

28 The shedule.exe utility for creating a replication query file

28.1 The purpose of the shedule.exe utility
The shedule.exe utility is designed for creating a query file on the Server-Receiver while replicating the archive on 
unconnected Servers (see Replicating archive from unconnected servers using the removable storage section).

28.2 Starting and shutting-down the schedule.exe utility
To start the utility start the schedule.exe file in the Tools\Replication folder of the Axxon PSIM installation directory. 
For example:

 C:\Program Files\Axxon PSIM\Tools\Replication\shedule.exe.

 

As the result the dialog window of the schedule.exe utility is opened.

https://docs.axxonsoft.com/confluence/display/PSIM100en/Replicating+archive+from+unconnected+servers+using+the+removable+storage
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To close the schedule.exe utility, click the  button or select Exit in the File menu.

 

Note.

The error message is displayed at opening the schedule.exe utility when users or the Camera objects are 
not created in the Axxon PSIM software under the Computer/LOCALHOST object corresponding to the 
Receiver. It is needed to create required objects and restart the system.


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1.
2.

3.
4.
5.

6.

7.
8.

28.3 Using the schedule.exe utility

28.3.1 Creating the query file for replication
To create the query file do the following:

Connect the removable storage to the Receiver.
Select the user registered the Axxon PSIM™ software in the Query executor drop-down list (1).

Select the Computer object corresponding to the Data source in the Computer drop-down list (2).
In the corresponding drop-down list select the Camera object the archive of which is to be copied (3).
Specify the time period for which the archive from selected camera is to be copied in the From: and To: 

fields using the mask or calendar that is displayed by clicking the  button (4).
Click the Add button (5).
The task is added to the list (6).

Repeat steps 2-6 for all required Sources.
Save the query file.

The query file is now created.

Note.

Select the task and click the Delete button to delete it from the list (7).

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28.3.2 Saving the query file
To save the query file do the following:

Select Save in the File menu.

Select the removable disk where the query file is to be saved in the drop-down list of the opened dialog box 
(1).

Click the OK button (2). The query file is saved on the selected disk.

The query file is now saved.

28.3.3 Opening the query file
To open the query file do one of the following:

Specify the disk where the query file is. For this:

Note.

 The Removable disks are not found message will be displayed if the removable storage is not 
found while saving the query file.



Note.

 If there is the PSIMBackup folder on the removable storage, then the dialog box asking to delete 
this folder is displayed. Click the OK button.


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Select Open drive in the File menu.

Select the query file in the drop-down list (1).

Click the OK button (2).
The utility detects and opens the query file which is in the root of selected disk.
Select the query file manually. For this:
Select Open file in the File menu.

Select the psim_task.xml file containing the query parameters using the standard opening dialog.

The query file is now opened.

Note.

The Removable disks are not found message will be displayed if the removable storage is not found 
while openning the query file.


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29 The SyncProtocol.exe utility to synchronize event log 
database

29.1 The purpose of the SyncProtocol.exe utility. Starting and shutting-
down the utility

Purpose

The SyncProtocol.exe utility is designed to synchronize Server/Client Event log database with databases of 
other Servers/Clients by command if the auto synchronization is disabled.

The auto synchronization is disabled on the Computer settings panel using the Only local protocols checkbox. If 
this checkbox is set checked, then the auto synchronization is not performed – see Configuring events logging.

Before starting synchronization using the SyncProtocol.exe utility it is required to configure synchronization on the
Computer settings panel by specifying the computers for synchronization and the Event Viewer database 
connection string – see Configuring the Event Viewer databases synchronization.

There is no synchronization with computers for which sending events is disabled in the Architecture tab 
(see Configuring the interaction of distributed system components). If the Send events checkbox is set checked, 
but checkboxes for all the events are set unchecked, then the events that cannot be disabled will be synchronized 
(for instance, SLAVE and macro events).

Starting and shutting-down the utility 

Start the SyncProtocol.exe utility from the Tools folder in the Axxon PSIM installation folder (by default, C:\Program 
Files (x86)\Axxon PSIM\Tools).

The utility dialog box is shown in the figure.

To shut down the SyncProtocol.exe utility click the  button in the upper-right corner of the window.

https://docs.axxonsoft.com/confluence/display/PSIM100en/Configuring+events+logging
https://docs.axxonsoft.com/confluence/display/PSIM100en/Configuring+the+Event+Viewer+databases+synchronization
https://docs.axxonsoft.com/confluence/display/PSIM100en/Configuring+the+interaction+of+distributed+system+components
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29.2 Synchronization of event log database using the SyncProtocol.exe 
utility

Synchronize the event log database using the SyncProtocol.exe utility as follows: 

Preconfigure the system and start the SyncProtocol.exe utility (see The purpose of the SyncProtocol.exe 
utility. Starting and shutting-down the utility).
Click the Synchronize button (1).

The information on the synchronization process is displayed in the Synchronization log field (2).
When the process is completed shutdown the utility by clicking the  button.

The event log database is now synchronized using the SyncProtocol.exe utility.
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30 The Axxon Player utility for viewing and converting the video 
archive

Please see the documentation here.

https://docs.axxonsoft.com/confluence/display/axplay/Documentation
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31 The openRTSP.exe utility for checking RTSP workability
The openRTSP.exe utility is a console application without a graphical user interface. This utility is intended for use 
in scripts to check workability of the RTSP Server module. Please visit http://www.live555.com/openRTSP/ for 
details about the utility.

The openRTSP.exe file is located in the <Axxon PSIM installation directory>\Tools folder.

An example of a script to test the workability of RTSP is given below. This script runs the openRTSP.exe utility by 
timer, then the utility takes 1 sec of video and checks the status of the RTSP Server. If a rejection from the RTSP 
Server itself is received, the StreamingServer.run process is restarted.

function check_cam(addr)
{
  var scmd = "./Tools/openRTSP.exe -V -D 10 -d 1 "+addr;
  DebugLogString("run:"+scmd);
 
  var s = run_cmd_timeout(scmd, 10000);
 
  DebugLogString(s);
  if(s.indexOf("Receiving streamed data")< 0)
  {
    DebugLogString("restarting");
    var msg = CreateMsg();
    msg.StringToMsg("SLAVE|COMP_NAME|EXECUTE|
restart<1>,command<streamingserver.run>"); //change COMP_NAME to the name of the 
computer where the process runs
    DoReact(msg);
  }
}
 
if(Event.SourceType == "LOCAL_TIMER" && Event.SourceId == "TEST_RTSP")
{
  check_cam("rtsp://127.0.0.1:5544/1"); //the link is formed as described in the 
"Configuring the RTSP Server Module" section
  check_cam("rtsp://127.0.0.1:5545/4");
}

Note.

Create and configure the Timer object for the required check period – see Creating and using the Timer 
object.



http://www.live555.com/openRTSP/
https://docs.axxonsoft.com/confluence/display/PSIM100en/Creating+and+using+the+Timer+object
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32 The Convert.exe utility for correcting modification dates of 
video archives

32.1 The purpose of the Convert.exe utility
The Convert.exe utility is designed for restoring changed creation dates of video archive files. For example, file 
creation dates may be changed (corrupted) while transferring an archive from one computer to another. This may 
lead to incorrect playback of the archive.

32.2 Starting and shutting-down the Convert.exe utility
The Convert.exe utility can be operated in two modes:

Correction of records creation dates. To use this mode, start the utility from the Tools folder of the Axxon 
PSIM installation folder. Example: C:\Program Files (x86)\Axxon PSIM\Tools\Convert.exe.
Correction of records creation and modification dates. To use this mode, start the utility from the Tools 
folder of the Axxon PSIM installation folder with the -FULLMODE parameter.

The Convert.exe utility dialog box will open.

To shutdown the Convert.exe utility, click the Close button.

32.3 Restoring changed creation dates using the Convert.exe utility
The Convert.exe utility allows restoring the creation date of a video archive file. To make the restoration, start the 
utility (see the Starting and shutting-down the Convert.exe utility section). A console window will open starting the 
process of searching the Video folder on each of the available disks. Then, replacing of modification date for 
creation date will start automatically. This process will take some time depending on the archive size. For example, 
restoring dates in a 500 MB archive will take about 10 seconds. When all dates are replaced, the Convert.exe window 
will close by itself.
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32.4 Working with the Convert.exe utility using the command prompt
One can work with the Convert.exe utility using Windows command prompt. The following startup parameters are 
in use:

TZ +hh:mm – changing date of file creation and modification for hh hours and mm minutes.
PATH – specifies the path to the archive folder with files date of creation (modification) of which is to be 
restored.
FULLMODE – running the utility in order to correct the date of creation and modification.
FORMAT is similar to FULLMODE. It also converts archive files to a format optimized for high-resolution 
archiving. The execution time of the FORMAT operation is comparable the the time required for a full 
conversion of the archive on the disk, because it requires reading every frame and creating a backup copy of 
the files while they are being converted. After the format of the archive or record has been updated, the 
execution time of subsequent conversions in FULLMODE will become the same as during an ordinary 
conversion.

Examples of commands for working with the Convert.exe utility using the command prompt:

Convert.exe PATH "H:\Video\03-09-12 15" FULLMODE 
Running this command the Convert.exe utility will restore the date of file creation and modification in H:
\Video\03-09-12 15 folder.
Convert.exe TZ +01:00
Running this command the time of file creation and modification will change for an hour. For instance, the 
“17-09-12 13” folder will be renamed as “17-09-12 14”.

Note.

These examples assume using a command prompt in <Axxon PSIM>\ Tools folder.

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33 The SignCheck.exe utility for checking the authenticity of 
exported frames

33.1 Starting and shutting-down the SignCheck.exe utility
To start the SignCheck.exe utility, do one of the following:

Start the utility from the Windows taskbar. Click Start, then Programs, then Axxon PSIM, then Tools, then 
Check Digital Signature.
The SignCheck.exe utility is available from the Start menu with the following installation types of the Axxon 
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2.

PSIM software: Server, Remote administrator workstation, Remote client.

Start the utility from the Tools folder of the Axxon PSIM program folder. Example: C:\Axxon 
PSIM\Tools\SignCheck.exe.

The SignCheck dialog box will open.
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To close the SignCheck.exe utility, click the Close button.

33.2 The purpose of the SignCheck.exe utility
The SignCheck.exe utility is designed for checking the authenticity of a frame exported into BMP or JPEG format 
using the Converter.exe utility.

33.3 Using the SignCheck.exe utility
To verify the frame authenticity, do the following:

Start the utility (see Starting and shutting-down the SignCheck.exe utility section).

Select the file with exported frame to check, using the   button and a standard dialog box for opening 
files.

The SignCheck window will show the information about the selected frame.

The following information is displayed:

AxxonSoft export frame – digital signature title.
Frame time – date and time stamp of this frame in the recording.
Export time – date and time of exporting this frame to a file.
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6.
7.

Camera – ID of the camera from which the recording was made.
System – the software that made the recording.
Computer – name of the computer this software is installed on.
User – user name of this computer.

If the frame cannot be authenticated, or the digital signature is missing, the "Verification failed” message will be 
displayed.
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34 The idb.exe utility for converting databases, selecting 
database templates and making backup copies of databases

34.1 The purpose of the idb.exe utility
The idb.exe utility is designed for database administration in Axxon PSIM software. It provides the following 
functionality:

Connecting to the Axxon PSIM database.
Setting up the database synchronization.
Creating backup copies of a database.
Restoring a database from its backup copy.
Changing the database template (see Interface elements of the idb.exe window).
Separating the events log into an individual database.

34.2 Running and shutting down the utility
Shut down Axxon PSIM before running the idb.exe utility.

The idb.exe utility is run from the Axxon PSIM installation directory. For example: «C:\ Program Files \Axxon 
PSIM\idb.exe».  

The idb.exe dialog box will open.

https://docs.axxonsoft.com/confluence/pages/viewpage.action?pageId=235441450
https://docs.axxonsoft.com/confluence/display/PSIM100en/Database+synchronization+setup


PSIM 1.0.0-1.0.1 (english) – Additional Utilities for the Axxon PSIM Software

The idb.exe utility for converting databases, selecting database templates and making backup copies of databases– 170

To confirm the changes and shut down the utility, click the OK button. To shut down the utility without saving the 
changes, click the Close button ( ).

34.3 Interface elements of the idb.exe window
The figure below shows the idb.exe dialog box.
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The table describes the interface elements of the idb.exe utility dialog box.

№ Element 
name

Description Default value Allowed values

1 Select 
data 
source

The drop-down list for selecting the 
database: local Configuration database, 
Event protocol database, or a remote 
database for synchronization

Basic data Basic data – local 
Configuration database

Synchro source – 
remote database for 
synchronization

Protocol – Event 
protocol database

Titles – Captions 
database

Other values are used 
when working with 
vertical solutions
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№ Element 
name

Description Default value Allowed values

2 Descripti
on

The information field that displays the 
description of the selected data source 
from the Select data source dropdown 
list

Axxon PSIM main 
database

"Axxon PSIM" main 
database – local 
Configuration database

Synchro source – 
remote database for 
synchronization

"Axxon PSIM" system's 
external protocols 
database – Event 
protocol database

Titles database – 
Captions database

Other values depend on 
the availability of the 
databases for the 
installed vertical 
solutions.

3 Use The checkbox for enabling or disabling 
the selected database usage. When set, 
the Configure button becomes active, 
which is used for setting up the 
connection to the database

Checked Checked – database is 
connected

Clear – database is not 
connected

4 Move 
database

The button used to transfer MS SQL 
Server database files (.mdf and .ldf) to 
the specified folder. The user should 
have the rights to create files in this 
folder. When the files are moved, the 
database is automatically attached.

Note. It is possible to move only the local 
DB (Basic data data source). When using a 
remote DB (Synchro source data source), 
files can not be moved

Active Active – the idb.exe 
utility is connected to the 
MS SQL format database

Inactive – the idb.exe 
utility is not connected 
to the MS SQL format 
database

5 Configur
e

The button opens the Data Link 
Properties dialog box to configure the 
database connection. This button is 
active if the Use checkbox is set

Active Active – the idb.exe 
utility is connected to the 
database

Inactive – the idb.exe 
utility is not connected 
to the database
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№ Element 
name

Description Default value Allowed values

6 The 
Connecti
on string 
informati
on field

The information field displaying the 
summary about the database 
connection parameters

Depends on the 
database 
connection 
parameters, the 
server configuration 
or Remote 
Administrator's 
workstation 
configuration 

Displays the combination 
of the following 
parameters:

Provider, Integrated 
Security, Persist Security 
Info, Data Source.

The Provider parameter 
can take the following 
values:

SQLOLEDB.1 – when 
using the MS SQL 
server format 
database;
Microsoft.Jet.OLEDB.
4.0 – when using the 
MS Access format 
server database

Other values are not 
used.

The Integrated Security 
parameter can take the 
following values:

SSPI – authentication 
on MS SQL server 
using Windows 
account information;
parameter not 
shown – 
authentication on MS 
SQL server using the 
user login/password, 
or using MS Access 
format database

The Persist Security 
Info parameter can take 
the following values:

True – allow saving 
the password for 
automatic 
connection to the 
database;
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№ Element 
name

Description Default value Allowed values

False – do not allow 
saving the password 
for automatic 
connection to the 
database

The Data Source
parameter can take the 
following values:

the name of the MS 
SQL server used for 
managing the 
database;
the path to the .mdb 
file of the MS Access 
format database

7 Informati
on field 
and the 
Select 
dbi-file 
button

The information field and the button for 
selecting and displaying the database 
structure .dbi file. The updated database 
will have the structure specified in this 
file

C:\Program 
Files\Axxon 
PSIM\psim.dbi

The full path to the .dbi 
file

8 Informati
on field 
and the 
Select 
dbi-file 
button

The information field and the button for 
selecting and displaying the information 
about the .ddi file with system objects, 
events and reactions

C:\Program 
Files\Axxon 
PSIM\Languages\en
\Axxon PSIM.ddi

The full path to the .dbi 
file

9 Create 
backup 
copy (MS 
SQL)

The button for starting the process of 
creating a backup copy of the database. 
This button is active if the idb.exe utility 
is connected to the MS SQL format 
database

Active Active – the idb.exe 
utility is connected to the 
MS SQL format database

Inactive – the idb.exe 
utility is not connected 
to the MS SQL format 
database
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№ Element 
name

Description Default value Allowed values

10 Restore 
from 
backup 
(MS SQL)

The button for restoring the database 
from a previously created backup

Active Active – the idb.exe 
utility is connected to the 
MS SQL format database

Inactive – the idb.exe 
utility is not connected 
to the MS SQL format 
database

11 Clear 
protocols

The checkbox that excludes the Event 
log database from the created database 
backup copy. It is recommended to set 
this checkbox if the size of the Event log 
database is too large, and there is no 
need to include the Event log in the 
backup copy.

The setting is available only for Axxon 
PSIM base database

No Checked – the database 
backup copy does not 
include the Event log 
database

Clear – the database 
backup copy includes the 
Event log database

12 Update 
database

The button for starting the process of 
updating the database structure. The 
structure is updated according to 
the .dbi file specified in the Select dbi-
file field

Active Active – the idb.exe 
utility is connected to the 
Configuration database

Inactive – the idb.exe 
utility is not connected 
to the Configuration 
database

13 Create 
dbi-file

The button for creating a database 
structure .dbi file (template)

Active Active – .dbi file creation 
is allowed

14 The 
Protocol 
informati
on table

The information table that displays the 
progress of database processing: 
converting, structure updating, creating 
backup copy, etc.

Empty Information messages 
about the progress of the 
database processing.

The blue “i” icon 
indicates that the 
processing step has been 
successfully completed

The red “!” icon indicates 
the errors in the 
processing step

A blue tick icon indicates 
the completion of the 
processing
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№ Element 
name

Description Default value Allowed values

15 OK The button for saving the database 
connection parameters and shutting 
down the idb.exe utility

Active Active – saving database 
connection parameters 
and shutting down the 
idb.exe utility is allowed

Inactive – the utility is 
still processing the 
database

34.4 Using the idb.exe utility
The idb.exe utility allows the administration of the databases of the Axxon PSIM system. Instructions on how to use 
the utility for administering databases are given in Axxon PSIM™ software database management section.

When you switch between databases using the Select data source drop-down list (see Interface elements of the 
idb.exe window), note that the specified parameters for connecting to the currently selected database are partially 
reset. This is due to the Microsoft security policy. In order for the settings in the Connection string field to be saved, 
do the following before you switch to the administration of another database:

Make sure that the database which connection settings should be saved is selected in the Select data 
source list (1).

Click the Configure button (2).

Note.

The Windows Firewall/ICS service is to be enabled to use the idb.exe utility.


https://docs.axxonsoft.com/confluence/display/PSIM100en/Appendix+3.+Axxon+PSIM+software+database+management
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In the window that opens, go to the All tab (3).

Left double-click on the Persist Security Info parameter (4).
Set the parameter value to True (5).

Click OK (6).
Click OK on the Data Link Properties window to update the settings and close the window.
Click OK in the IDB utility window to save the settings.

As a result, the next time you switch to the selected database, the settings for connecting to it will not be reset.

34.5 Working with idb.exe utility with the use of keys
It is possible to run idb.exe utility with keys. For this click Start -> Run. Type the path to idb.exe utility and the 
required key after / in the appeared window.
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To display keys, supported by the utility, use the command «idb.exe /?».

idb.exe  utility supports the run with the following keys:

«/update» − the key of running the hidden updating of database (uses psim.dbi file).
«/sync» − the key of database synchronization with the source of data.
«/backup» − the key of running the process of creation the backup copy of Axxon PSIM database. Use the 
-protocol option to exclude the Event protocol database from the backup (i.e., the full command in this case 
would be: /backup -protocol).
The backup copy is created to the address «C:\Users\user\Documents\Axxon PSIM». It is used when the 
idb.exe utility is connected to MS SQL database.
«/restore» − the key of running the database recover from the previously created backup copy. It is used 
when the idb.exe utility is connected to MS SQL database.
«/set_cs key=value» − the key of saving the connection string to the system registry (summary on parameters 
of connection to database).
«sql_convert:db_name mssql2000|mssql2005» − the key of running the database conversion process from 
MS Access to MS SQL format. It is used when the idb.exe utility is connected to MS Access database.

Example. To convert MS Access to MS SQL database using the key, do the following:

Use the Run command (Start -> Run), specify the key: C:\Program Files\Axxon PSIM\idb.exe /sql_convert.
Click the OK button. As a result the dialog box of the idb.exe utility is displayed.
Select MS Access database in the Select data source dropdown list.
Click the Convert MS Access to MS SQL database button.

http://sql_convertdb_name
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As a result the box suggesting to select MS SQL server is displayed. Click the OK button to continue.

As a result the Data Link Properties box is displayed. Un this box you are to:
select the Server name in the dropdown list;
specify the user name and password to log in the Server;
set the Allow saving password checkbox checked;
click the Test Connection button;
click the OK button to save the changes.
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10.
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As a result the dialog box suggesting to enter the database name is displayed.

Enter the database name or leave the name suggested by the system. Click the OK button.
As a result the process of converting MS Access into MS SQL database starts. The progress of the process is 
displayed in the Protocol table of the idb.exe utility.
When the database is converted, shut down the idb.exe utility (see Running and shutting-down the utility 
section).

MS Access database is now converted to the MS SQL format.

34.6 Extracting event protocol into an individual database
External event protocol is created with the help of the idb.exe utility.

It is necessary to create the protocol database beforehand with the help of the MS SQL Server program. Do the 
following:

Open Microsoft SQL Server Management Studio Express;

Attention!

If Time and Attendance module is in use (the module is a part of ACFA PSIM subsystem) use the 
RemoteProtocolConnector utility to extract event protocol into a separate database – see Axxon PSIM Web 
Report System. User Guide (the most recent version of this document is available in AxxonSoft 
documentation repository).



Note

To operate the Report System, which is a part of base Axxon PSIM, the method of extracting the event 
protocol into a separate database is used. The method is described in this section, i.e. using the idb.exe 
utility. Configuration of the connection to such protocol DB is required in the Report System, which is a 
part of base Axxon PSIM (see Connecting to the Events Log (PROTOCOL table)).



https://docs.axxonsoft.com/confluence/display/ASdoc/AxxonSoft+documentation+repository
https://docs.axxonsoft.com/confluence/pages/viewpage.action?pageId=235441033
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2.

3.

Select Databases.

Right-click and select New Database…
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4.

5.
6.

1.

Specify the protocol database name in the Database name line in the New Database dialog box.

To create a new protocol database, click the OK button. 
Shut down Microsoft SQL Server Management Studio Express by clicking the Close button in the upper right 
corner of the dialog box.

As a result, the protocol database is created.

To enable the external event protocol, do the following:

Run the idb.exe utility (see Running and shutting down the utility).
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2.

3.

4.

5.

Select the Protocol database from the Select source database drop-down list.

To enable the Protocol database, set the Use checkbox (1).

As a result, the Configure button becomes active (2). To connect to the Protocol database, click the 
Configure button.
As a result, the Data link properties dialog box appears. Go to the Provider tab.



PSIM 1.0.0-1.0.1 (english) – Additional Utilities for the Axxon PSIM Software

The idb.exe utility for converting databases, selecting database templates and making backup copies of databases– 184

6.

7.
8.
9.

Select the Microsoft OLE DB Provider for SQL Server from the OLE DB Provider(s) list (1).

Click the Next button (2).
You will be automatically redirected to the Connection tab.
Do the following in the Connection tab:
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a.

b.
c.
d.
e.
f.

g.
10.
11.

Select a server name from the Select or enter a server name drop-down list (1). 

Specify the user name in the User name field and specify the password in the Password field (2).
Set the Allow saving password checkbox (3).
Select the protocol database in the Select the database on the server drop-down list (4).
Click the Test connection button (5).
If the connection to MS SQL Server is successfully established, then the Test connection succeeded
message appears.

Click the OK button in the message box. The box closes automatically.
Select the dbi file. Click the button next to the Select dbi-file information field.
As a result, the Open dialog box appears.



PSIM 1.0.0-1.0.1 (english) – Additional Utilities for the Axxon PSIM Software

The idb.exe utility for converting databases, selecting database templates and making backup copies of databases– 186

12. Select the database structure file – C:\Program Files\Axxon PSIM\protocol.dbi.
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13.

14.
15.
16.

1.
2.

3.

4.

Click the Update database button to update the database in accordance with the psim.dbi file specified in 
the Select dbi-file field.

As a result, database updating will start. Information about this process is displayed in the Protocol table.
Database is updated, when there is the Database Updating is completed! message in the Protocol table.
To save Axxon PSIM connection parameters to the Protocol database, click the OK button. As a result the 
dialog box closes automatically.

External event protocol is created and connected.

34.7 Creating the database backup copy
To create the MS SQL database backup copy, use the idb.exe utility. To create the backup copy, do the following:

Run the idb.exe utility (see Running and shutting down the utility).
Select the Basic data MS SQL database from the Select data source dropdown list.

If it is not required to include the Event protocol in the backup copy of the database, set the Clear protocols
checkbox. This checkbox is not available if the vertical solution database is selected.
Click the Create backup copy (MS SQL) button.

Note

Select the vertical solution database to create a backup copy of the vertical solution database. For 
example, for Face PSIM the data source is Face.


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5. As a result, the Save as dialog box appears. Select the address and type in the name of saving backup copy.

a.

b.

Note

While creating the MS SQL database backup copy, the created backup copy will be saved on the 
computer where the database server is installed, in case of Axxon PSIM software and database 
server are located on different computers connected through the network. To save created backup 
copy on the computer where Axxon PSIM is installed, do the following:

Create the folder available through the network on the computer where Axxon PSIM is 
installed. Provide access to the created folder from the computer where the database server 
is installed.
Specify the path to the created folder in the Save as window.


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6.

7.

8.

1.
2.
3.

4.

As a result, the process of backup copy creation starts. Information on this process is given in the Protocol 
information table.

The backup copy is created when the Creation of a backup copy is completed! message appears in the 
Protocol table.

Click the OK button. The dialog box closes automatically.

The MS SQL database backup copy is created.

By default the database backup copy is created at: C:\Documents and Settings\<user name>\My 
documents\AxxonSoft\Axxon PSIM\Data\psim.sql.bak. In case you cannot change the folder for storing the 
database backup copy while the backup copy creation, do the following:

Call the Run function (Start → Run). Type in regedit in the opened dialog box.
Click the OK button. As a result, the Registry editor dialog box opens.
Create the string parameter with the BackupFolder name in the HKLM\SOFTWARE\AxxonSoft\PSIM registry 
thread (see Adding string parameters to the registry).
Set the value of the BackupFolder parameter: type in the address of the folder for storing the database 
backup copy (e.g. C:\Documents and Settings\AVP\Desctop\Backup). 
If it is necessary to store the database copy on the network disk, then the UNC path to the network folder 
(with the recording access) should be specified on the disk in the \\ServerName\ShareName format. Take 

Note

The backup copy (MS SQL) can be created using the macro.


https://docs.axxonsoft.com/confluence/display/PSIM100en/Adding+string+parameters+to+the+registry
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a.
b.

5.

6.

7.

1.
2.

into account that all network resources that require additional authentication should be connected using 
the same username as for running the SQL Server service. To find out and/or change the user that runs the 
SQL Server service, do one of the following:

Using the SQL Server Configuration Manager utility.
Run Start – Control panel – Administrative tools – Services, right-click the SQL Server service and 
select Properties in the feature menu. In the opened SQL Server service dialog box, go to the Log On
tab.

As a result, the string parameter of the key with the specified value is created.

Call the Run function (Start → Run). Type in the «C:\Program Files\Axxon PSIM\idb.exe /backup» key in the 
opened dialog box.
Click the OK button.

As a result, the psim.sq.l.bak database backup copy is created in the folder specified as the value of the 
BackupFolder parameter.  

34.8 Restoring database from backup copy
The database backup copy is created using the idb.exe utility (see Creating the database backup copy). Database 
restoring from backup copy is also performed using the idb.exe utility in the following way:

Run the idb.exe utility (see Running and shutting down the utility).
From the Select data source: drop-down list select the MS SQL database – Basic data.

Note

Select the vertical solution database to create a backup copy of the vertical solution database. For 
example, for Face PSIM the data source is Face.


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3.

4.
5.

6.

7.

 Click the Restore from backup (MS SQL) button (1).

Using the standard dialog box for opening files, select the created earlier file with database backup copy.
As a result, the process of database restoring from backup copy will start. Information about process is 
displayed in the Protocol informational table (2).
Restoring is completed when the Restoration from a backup copy is completed! message will be displayed 
in the Protocol table.
To finish the work click the OK button. The window will close automatically (3).

Database restoring from backup copy is completed.
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